


Configuration Guide

2

Introduction

This guide will include information and step-by-step instructions that will allow administrators and developers to 
perform specific actions and implement specific use cases within their Service Management Automation X 
environment. For more general information on the general concepts regarding Service Management Automation X, 
please see the companion “Getting Started Guide” for Service Management Automation X.
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Business Rule Examples

Introduction

In this section we will take a look at specific business rules that may be helpful to a number of Service Management 
Automation X administrators. You may find a business rule that meets your rules exactly, or you might find that you 
can modify one of these examples slightly to meet the functionality that you need.
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Remove a value from a list using a rendering rule
While setting up the completion codes that the IT agents use when closing requests the administrator decided that 
the value ‘Solved by Social’ was not required in the list of available completion codes. In order to filter this value out of 
a list a new ‘Define suggested values by a list to list mapping’ rule needs to be added. 

Enter the name of the list for both the source and destination lists. Map the names of the values to themselves, if a 
value is not needed do not add a mapping and it will not appear after the rule is applied. If there is a security reason 
that the value is being removed, a validation rule needs to be added to make sure that it can’t be populated using a 
different method than the UI.
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Set a field to a group that will be moved when dev2prod runs
The administrator wants to set the service desk group on all requests created through the Service Management 
Automation Service Portal to a group named ‘Initial Ticket Reviewers’. When the dev2prod process runs the rule 
needs to use the group with the same name on the production tenant. The administrator needs to create a set field 
rule using the group_id_by_upn() function. Click on the ‘fx’ button to use the function. In order to not update the field 
every time or overwrite a value that may be set later in the workflow an ‘if’ condition should be used. It’s also possible 
to put the rule in a location that will only run once, for example entering the ‘Log’ phase. In the example an If condition 
is added to make sure that the field is not already set, and if it’s not set and entering the ‘Log’ phase then the service 
desk group is set.
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Make an entity read only after it has been closed 
There are multiple ways to make an entity read only, below are a few examples of different ways it can be done.

Option 1:

Add the validation rule ${current_update.PhaseId.IsChanged} to the ‘Done’ meta phase of the request entity 
workflow. This option won’t allow the request to be updated under any circumstances after it reaches the ‘Done’ 
phase. 

Option 2:

Add the validation rule ${current_update.PhaseId.IsChanged || current_user.IsPermitted('EMS-Admin-
Template(entityType=Request)')} to the ‘Done’ phase of the request entity workflow. This rule won’t allow the entity 
to be updated if it is in the ‘Done’ meta phase unless the currently logged in user has admin rights defined in their 
role.

Option 3:

Add the validation rule ${current_update.PhaseId.IsChanged || current_user.IsPermitted('EMS-Admin-
Template(entityType=Request)') || (now() - entity.CloseTime)<3600000)} to the ‘Done’ phase of the request entity 
workflow. This rule won’t allow the entity to be updated if it is in the ‘Done’ step unless the currently logged in user 
has admin rights defined in their role or the request was closed within the last hour.
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Add the date and time in a readable format to a comment
Service Management Automation X dates are all stored using a unix timetamp, these values need to be converted 
using the ‘format’ function in order to display the date in a user friendly manner. The dates are stored in the local 
server time, so a time zone offset needs to be used to display the date in local time. For example if the server location 
is in London, England, and the user wanted the time to appear as the local time in Moscow, the time offset between 
London and Moscow needs to be added to the now() function. Three hours is 10800000 milliseconds, so the rule to 
add this would be: ${format(now()+10800000,'long')}. The long parameter always adds the time zone of the server, 
in the below case PDT. Using the short parameter removes the time zone.

The entry in the comment would appear as follows:

Using ${format(now()+10800000,'short')} instead of ‘long’ would result in:

https://en.wikipedia.org/wiki/Unix_time
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Only display 3rd level Record Categories on an Incident/Request/Change
In the category field on the request or incident form it’s possible to only display the level 3 record categories. The 
following rule will search the level2Parent field and confirms that the value is populated, the level2parent field 

contains the name of the parent of the 3rd level value so it will only be populated if the record is a 3rd level category. 
A dummy value is used for the comparison, in this case ‘Empty’. The rule will only compare it to valid values; 
categories with a null in the field will not be displayed in the drop down list.

Concatenate text contained in two different fields into one
In some case it is possible that text needs to be added to a field or the values of two fields needs to be added to one. 
The concat function is able to accomplish this. Create a ‘Set field’ rule and using the ‘fx’ option to enter ${concat('My 
Prefix to the title ',entity.RequestsOffering.DisplayLabel)}. Best practice (depending on the use case) is that the 
rule should be run only once by either using a condition or adding the rule to a transition between phases.

Would result in:
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Suggest solutions for the Service desk group using the union function
A typical use case for selecting the assignment group on a request may be to use a rendering rule to only make 

available for selection the 1st, 2nd and 3rd level support groups assigned to the service. To accomplish this in a 
single rule the union function may be used. Add the suggested solutions filter in the rendering forms rule section. 
Then select the service desk group field, select the ‘Id’, and ‘in’ $
{union(entity.RegisteredForActualService.SupportLevel1Group.Id,entity.RegisteredForActualService.Support
Level2Group.Id,entity.RegisteredForActualService.SupportLevel3Group.Id)}
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Suggest solutions to set the Service desk group using the union and intersect 
functions
It is possible to create multiple lists of values and then only use results that exist in both lists to populate something. 
In this example, the service desk suggested solution field will only show a group if the requested for person’s 

organizational group is one of the 1st, 2nd or 3rd level support groups assigned to the service. 

The behavior is illustrated below: 

The resulting request would appear as:
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Send notification to first non-empty recipient
One common use of the expression l  anguage is building a list of recipients. In the below example the email will be 
sent to the first non-empty value, either the manager of the reported by person or the reported by person themselves.
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Sending Parent Entity information in Approval or Task emails
Email notifications sent when a task or approval is created often need to include information from the parent request 
or change. Since change and request share the same notification templates for tasks and approvals, the Service 
Management Automation X administrator may use a conditional rule to show relevant information for the relevant 
parent type. Conditional rules are only available in notification templates. 

In this example the email notification template used to send email to the task assignee will be updated to include 
information about the parent request or change. The email notification template (named ‘Send task assigned to 
person notification’) is located in Records -> Task -> Notifications:

If the parent of the task is a request, the notification should include the phase, name, service, service desk group, and 
creation date of the request. If the parent of the task is a change, the notification should include the phase, reason for 
change, risk, change type, change owner, change owning group, service model and the scheduled start and end date 
of the change. 

When there are common field names in both the request and change entity only a single entry is needed in the 
template. The syntax used to access the parent information is ${:entity.parentEntity.fieldName}. The ‘PhaseId’ field 
is common to both entity types so the syntax added to the email template would be:
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The resulting request (or change) notification would look like:

Another approach when there are common field names is to use a conditional rule to allow for different text 
depending on the parent record type. The conditional rule uses the syntax <%=conditional_statement(boolean 
expression, text if true, text if false)%>. 

 In the example rule below the condition result of “true” would mean that the parent is a Request and the notification 
text should be ‘Request is in Phase Fulfill.’ If the parent was a change the condition would return ‘false’, and the 
notification would use ‘Change is in Phase Evaluate.’ The rules to show fields are added directly in the email template 
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as seen below:

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Request is in Phase $
{:entity.parentEntity.PhaseId},Change is in Phase ${:entity.parentEntity.PhaseId})%>

In the email notification template this would appear as:

If the parent is a request the notification would look like:

A common situation that occurs is that a field is unique to a particular record type. In this case we want the value to 
be present in the notification if it exists, but if the value does not exist we do not want any value to appear. One 
example is the ‘ReasonForChange’ field that is unique to change entities. We do not want any mention of this value in 
a request task notification. In this case the conditional rule only applies if it returns true and we do not include a false 
action. 

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Reason is $



Configuration Guide

17

{:entity.parentEntity.ReasonForChange})%>

Resulting email when the parent is a change:

For some notifications, a related attribute of a field must also be included in the field expression. For example, to 
display the ‘Owned by Person’ name, the “.Name” attribute needs to be included in the expression (not just the 
“entity.ParentEntity.OwnedByPerson” value). 

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Owner is $
{:entity.parentEntity.OwnedByPerson.Name})%>
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For date fields, the ‘format’ DSL must be used to display the date in a user friendly way.

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Scheduled End is $
{:format(entity.parentEntity.ScheduledStartTime, 'short')})%>

For the initial use case the following would be added to the template:

The resulting email from this template for a task on a change would appear as:
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The resulting email from this template for a task on a request would appear as:

If the field is empty the value will appear blank. An additional conditional rule may be added to remove the field if it is 
blank. In the example above changing the expert group condition to check to see if there is a value present would 
result in it only displaying the result if it is populated.

<%=conditional_statement(${:entity.ParentEntityType.ExpertGroup!=null},Requests Expert group is $
{:entity.parentEntity.ExpertGroup.Name})%>

Rules included in the template are:

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests is in Phase $
{:entity.parentEntity.PhaseId}, Change is in Phase ${:entity.parentEntity.PhaseId}})%>
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<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests was created on $
{:format(entity.parentEntity.CreateTime, 'short')})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Scheduled Start is $
{:format(entity.parentEntity.ScheduledStartTime, 'short')})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Scheduled End is $
{:format(entity.parentEntity.ScheduledStartTime, 'short')})%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Name is $
{:entity.parentEntity.DisplayLabel}, Change Name is ${:entity.parentEntity.DisplayLabel})%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Service Desk Group is $
{:entity.parentEntity.ServiceDeskGroup.Name})%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Expert group is $
{:entity.parentEntity.ExpertGroup.Name})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Risk is $
{:entity.parentEntity.RiskAssessment})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Type is $
{:entity.parentEntity.ChangeWorkflowType})%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Owner is $
{:entity.parentEntity.OwnedByPerson.Name}, Change Owner is ${:entity.parentEntity.OwnedByPerson.Name})
%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Request Owning group is $
{:entity.parentEntity.OwnedByGroup.Name}, Change Owning group is $
{:entity.parentEntity.OwnedByGroup.Name})%>

<%=conditional_statement(${:entity.ParentEntityType=='Request'},Requests Service is $
{:entity.parentEntity.RegisteredForActualService.DisplayLabel})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Service is $
{:entity.parentEntity.AffectsActualService.DisplayLabel})%>

<%=conditional_statement(${:entity.ParentEntityType=='Change'},Change Model is $
{:entity.parentEntity.BasedOnChangeModel.DisplayLabel})%>
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Passing parameters to notification templates
There may be situations where the information needed in an email notification is not supported by the standard DSL 
functionality. An example of this would be the name of the requester’s manager or the name of the owner of an 
assignment group. 

This rule example will add the following to the create request email notification:

• The requester’s manager’s email address.
• The name of the owner of the service desk group.
• The name of the 1st level support group of the actual service assigned to the request.

In order to add the parameters to the email notification, the following steps are needed:

• Creating the parameter name in the email notification template.
• Determining the DSL syntax for the fields that will populate the parameter in the template.
• Adding the DSL that captures the value into the rule that sends the notification.

Creating the parameter name

In the ‘Records’ editor, select the ‘Request’ entity and then locate the ‘CreateRequest’ template under the 
‘Notifications’ tab:

In the content of the email template add parameter reference names that will be used to store the desired field 
values. In this example the names are going to be ‘RequestersManagerName’. ‘OwnerOfServiceDeskGroupsName’ 
and ‘ServiceFirstLevelSupportGroupName’. The reference names can be any value and will only appear in the 
notification rule itself.
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Find the rule in the request workflow that will send the notification template edited with the parameters. Click on the 
parameters field of the rule.

The fields added to the notification will automatically appear in the form that appears.

Click on the function (‘fx’) button on each field and add the DSL expression that will look up each of the values. In this 
rule example the values added to the fields are ${entity.ServiceDeskGroup.Owner.Name}, $
{entity.RegisteredForActualService.SupportLevel1Group.Name} and ${entity.RequestedByPerson.Manager.Email}.
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The values will appear as below after getting added to the form.

The email the user receives then contains the required information, as seen below:
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Configuration Use Cases

Introduction

In this section we will take a look at specific use cases that might be of interest to Service Management Automation X 
administrators. For each use case we will walk through the necessary configuration steps needed to enable the 
functionality.

You might find a use case that exactly fits a business need, or you may be able to take a use case and modify it 
slightly to get the exact functionality that you are looking for.
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Automatic Assignment and Suggestions for Groups

Introduction

When process driven records (such as requests or incidents) are created in Service Management Automation X, it is 
often desirable to automatically assign them to a specific group based on information contained in the record. In other 
cases it may not be possible to assign the record to a specific group, but instead the system can provide the agent 
with a list of suggestions again based on information in the record. Both of these methods are accomplished using 
business rules.

There are two Rule Types that are commonly used to automatically set the initial group in a record:

• Set field 

• Set field based on routing definition

Both rules are used in the ‘After change’ section of the rules.

Note: The most common groups that are seen in auto-assignment are service desk group and expert group (for 
requests and incidents). However, the use cases and examples seen in this section may be used for any group field 
in a record. Simply specify the proper field name in the rules when they are defined.
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Use Case #1

When creating a new request, automatically set the service desk group to the level 1 support group of the actual 
service specified.

Configuration Steps - Summary

1. Create a ‘Set field’ rule in the request workflow

Configuration Steps - Detail

1. Create ‘Set field’ rule in the Request Workflow

The ‘Set field’ rule can be used to set a field to a specific value or to the result of an expression. For automatic 
assignment, the desired group may be set to a specific value or by an expression that looks up a group based on 
some other value in the current record (such as the service).

For this use case, the following set field rule is used during the ‘Classify’ phase of a request to set the group:

If ${entity.ServiceDeskGroup == null}

Set Service desk group to ${entity.RegisteredForActualService.SupportLevel1Group}

The condition of this rule first checks to see if the service desk is not already filled in (we don’t want to overwrite a 
value that the agent has entered). Next it specifies that we are going to fill in the ‘Service desk group’ field. Finally, the 
DSL expression finds the level 1 support group (a field in the service record) of the service that is entered into the 
current request.
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Use Case #2

When creating a new request, automatically set the service desk group based on a pre-defined routing definition. The 
routing definition allows for a group to be selected based on a combination of a service, location, and/or organization. 

Configuration Steps - Summary

1. Create the desired routing definition

2. Create ‘Set field based on routing definition’ business rule

Configuration Steps - Detail

1. Create the desired Routing Definition

Alternatively, the ‘Set field based on routing definition’ rule allows for a group to be selected based on a combination 
of a service, location, and/or organization. These values are taken from the current record (request, incident, etc.) 
and evaluated against a more complex set of rules to determine the proper assignment. The actual routing definition 
is created through a graphical interface, and must exist before the rule is created. More information on routing 
definitions may be found in the on-line help.

In this example we have a routing definition that selects a group based on a service and a location.

http://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/Search.htm#search-routing%20definitions
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2. Create ‘Set field based on routing definition’ business rule

The ‘Set field based on routing definition’ rule is used to set a field to a specific value based on a combination of 
service, location, and/or organization data. The rule will require the administrator to specify where each value should 
come from.

For this use case, the following“Set field based on routing definition” rule is used during the ‘Classify’ phase of a 
request to set the group:

If ${entity.ServiceDeskGroup == null}
Set Service desk group based on routing definition 
Service Based with 
Actual Services: entity.RegistredForActualService.Id
Locations: entity.RequestedByPerson.CurrentLocation.Id

In this use case we are using the location of the requested by person.
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Use Case #3

When an end user creates a request through the Service Management Automation X Service Portal, set the service 
desk group based on the following logic:

• For a specific service offering/incident model/change model, set the group based on one of:

◦ A specific routing definition - or -

◦ The support group field in the associated service definition - or -

◦ A specific group

• Or if the actual service is defined then set the group based on:

◦ A specific routing definition - or -

◦ The support group field in the service record - or -

◦ A specific group

• Or if the service is not defined but a location is part of a specific geography then set the group 
based on:

◦ A different location based routing definition

• Or set the group to a specific default group

Configuration Steps - Summary

1. Create business rules for each specific offering

2. Create the general business rules for the request record

Configuration Steps - Detail

1. Create business rules for each specific Offering

To perform the logic above rules need to be added not only to the record type in question, but also to each service 
offering/incident model/change model record that has specific rules. These rules are entered directly into the 
applicable record in either the ‘Default Values’ tab (if setting to a specific value) or the ‘Rules’ tab (if using a routing 
definition). Additionally, the configuration gives the option to run the specific rules either before or after the general 
record business rules. In order for our logic to succeed, it is important to run the offering/model rules before the 
general ones.
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2. Create the general business rules for the Request record

The remaining logic will be located in the general record rules. In this case the Incident record rules. For each rule the 
current value of the group field in question (service desk group in our case) is checked to see if it is still blank before 
attempting to supply a value.
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With these rules our initial logic is now met. The correct group will be set only if the current field has not already been 
filled in. Using this methodology, any number of automatic assignment rules may be defined in order to follow the 
assignment logic for any implementation.
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Use Case #4

In some situations it may be necessary to pass a particular record (request/incident/change/etc.) between multiple 
groups. Instead of relying on the agent to pick the correct entry from the entire list of groups, we want to suggest one 
or more groups to choose from. There are two rule types that are useful for this purpose, both of which should be 
used in the ‘Rendering forms’ section of the rules:

Define suggested values based on filter

Define suggested values based on routing definition

An important feature to note is that multiple rules can be configured for the same field, resulting in multiple 
suggestions being shown to the Agent when entering that field. Since each suggestion may be labeled differently, this 
can be a valuable tool to assist the Agent in selecting the right group.

Similar to the automatic assignment, these rules may be placed either in the general record (request/incident/etc.) or 
in the associated offering/model record. All suggestions (from both the general and associated rules) are shown to 
the agent when selecting the proper group.

Configuration Steps - Summary

1. Define suggested values based on filter

2. Define suggested values based on routing definition

Configuration Steps - Detail

1. Define suggested values based on filter

Using this rule type we can limit the possible groups to either a hard coded list or a list that matches a DSL 
expression. For this example, we will create a total of three rules that will display:

The level 1 support group of the associated Service (if one is specified)

A hard-coded list of service desks if there is no level 1 support group (or no service specified)

The level 2 and level 3 support groups of the associated service (if one is specified)

A list of all groups

The actual rules needed are:
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When the agent selects the service desk group field with a service that has a level 1 support group, they will see the 
following:

Whereas if there is no level 1 support group defined, they will see:
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2. Define suggested values based on routing definition

This rule has the same result of displaying the suggested groups to the agent, but instead of a simple filter a routing 
definition is used. Identical to the ‘set field using routing definition rule’, a combination of service, location, and 
organization may be used to dynamically select the suggested groups. The groups that are displayed is the 
combination of the ‘Default group’ that is used in the set field rule, as well as any ‘Suggested groups’ that have been 
defined. Note that each ‘node’ of the routing definition will display the number of groups, if any, that will be used as 
suggestions. To see the actual groups you must edit the node.
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The actual rule would look like:

This rule would then display the suggested groups in a section titled ‘Location routing’. This rule could be included 
with the previous rules in order to give the agent multiple suggestion options. However, it is recommended to keep 
the number of different suggestion rules to the minimum needed, otherwise the agent could actually become more 
confused about which to use.
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Configuration Rules Used

Included here is a list of the rules used in the above use cases in text form, so that they may be cut & pasted into 
the Service Management Automation X interface.

To automatically set the service desk group to the support level 1 group of the associated service: 

If ${entity.ServiceDeskGroup == null}
Set Service desk group to 
${entity.RequestedForActualService.SupportLevel1Group}

To automatically set the service desk group using a routing definition named ‘Location routing’:

If ${entity.ServiceDeskGroup == null}
Set Service desk group based on routing definition 
Location routing with 
Locations: entity.RequestedByPerson.CurrentLocation.Id

To suggest values for the service desk group based on hardcoded values:

If ${entity.RegisteredForActualService == null || entity.RegisteredForActualService.SupportLevel1Group == null }
Define suggested values for Service desk group with header Service Desks 
with filter Name IN ${union('Service Desk','Customer Service')}

To suggest values for the service desk group based on the level 1 support group of the related service (of an 
incident):

If ${entity.RegisteredForActualService != null}
Define suggested values for Service desk group with header Level 1 Support Group 
with filter Id IN ${entity.RegisteredForActualService.SupportLevel1Group.Id}

To suggest values for the service desk group based on the level 2 and 3 support groups of the related service (of 
an incident):

If ${entity.RegisteredForActualService != null}
Define suggested values for Service desk group with header Service Support Groups 
with filter Id IN ${union(entity.RegisteredForActualService.SupportLevel2Group.Id , 
entity.RegisteredForActualService.SupportLevel3Group.Id)}

To suggest all groups for the service desk group (only necessary if using another suggestion rule for service desk 
group):

Define suggested values for 
Service desk group with header All Groups 
with filter all records
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Creating Entitlements for Service Management Automation X Service 
Portal Users

Introduction

Entitlements restrict offerings, knowledge articles, service definitions, categories, and custom themes in the Service 
Management Automation X Service Portal to limited audiences in specified locations or belonging to specified user 
groups or roles. Adding entitlement rules will result in Service Management Automation X Service Portal users being 
able to view items that correspond to their location or group membership.

Use Case

A company named ABC Publishing has offices in three different cities in the United States. The three offices perform 
different functions: 

• San Diego takes care of all the printing activities

• New York takes care of all sales activities

• Detroit is responsible for marketing

The three offices use different applications and different types of infrastructure, so the offerings that IT provides are 
different for each office. However, there are common offerings that need to be available to all employees. 

 All of the offerings fall into three categories. The three categories are ‘Phone and Mobile’, ‘Applications’, and 
‘Network Connectivity’. The company wants to use entitlements to limit the offerings end users see based on their 
locations. The Service Management Automation X administrator needs to configure entitlements for the following 
offerings:

Offering Category San Diego New York Detroit
Create network 
login 

Network 
Connectivity

X X X

Grant access to 
Sales Force

Applications X

Installation of Adobe 
Photoshop

Applications X

Order new mobile 
subscription

Phone and Mobile X

Request PC Phone 
Service

Applications X X
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Configuration Steps - Summary

1. Configure the location for users

2. Create entitlement rules for each office location

3. Create entitlement rules for the parent locations

4. Add an audience to the category

5. Add an audience to the offerings

Configuration Steps - Detail

1. Configure the locations for users

Each user must have their location specified in their Person record. 

To add a location to a person, navigate to Administration > Master Data > People. Select the desired user and then 
expand the ‘Contact Information’ section. In the location field select one of the 3 locations described in the use case 
(San Diego, New York or Detroit). Repeat for all the users.

2. Create entitlement rules for each office location

To create an entitlement rule, navigate to the Administration > Master Data > People-> Entitlement Rules. Click 
new and enter the name and description of the rule. In this use case 3 entitlement rules will be created with the 
names ‘San Diego’, ‘New York’ and ‘Detroit’. 

For the entitlement rule named San Diego, in the ‘Rule Definition’ section select the location field and find the San 
Diego location and select it. For the other 2 cities repeat but select the correct city. Entitlement rules can be added 
based on location or role, in this case we are using location.

3. Create entitlement rules for the parent location

An entitlement rule can be created and used in the described use case using the parent location of the 3 cities. In this 
case North America/United states. Navigate to the Administration > Master Data > People-> Entitlement Rules 
and create a new entitlement rule named United States and in the location field select North America\United States. 
The United States entitlement rule will give permissions to any location that is assigned to a user whose location 
parent is North America\United States. In our example this means the 3 cities of San Diego, New York and Detroit.

4. Add an audience to the category

In many cases customer don’t want a category to appear for all end users. To restrict a category so that end users 
won’t see it we can use the entitlement rules we have created. Navigate to Service Catalog > Categories. Select the 
category that needs to be restricted, in this example select the ‘Phone and Mobile’ category. Expand the audience 
section and then select the United States entitlement rule. Once the entitlement rule is added and saved only those 
users whose parent location is the United States will be able to view the ‘Phone and Mobile’ category. If no audience 
was added then all users would be able to view the category, if the San Diego entitlement rule was added then only 
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those users whose location was San Diego would be able to view the category. 

5. Add an audience to the offerings

To restrict offerings that appear in each category the location based entitlement rules need to be added to the 
appropriate offerings. Navigate to Service Catalog > Offerings. In the use case to assign the correct entitlements to 
the ‘Create network login’ offering that is required for all 3 offices, either the United States entitlement rule can be 
applied or the 3 entitlement rules for San Diego, New York or Detroit could be applied. In the case where not all of the 
locations required access, apply the appropriate rules for those locations that do need access. Using the ‘Request PC 
Phone Service’ offering example, select the offering and in the audience list select the New York and Detroit 
entailment rules.

Notes

Locations are configured in the Administration-> Master Data -> Locations form. The hierarchy for locations is 
Region -> Country -> City -> Site -> Floor -> Building -> etc. This is visible in the location form when selecting the 
Type of location when added them.
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Data Domain Segmentation

Introduction

Data domain segmentation in Service Management Automation X provides the ability to restrict the visibility of 
specific records and actions (such as incidents, changes, or specific approvals) to specific people, roles, or groups. 

Data domain segmentation is composed of two parts:

1) Assignment of permissions to view particular data domains to a person, role, or group.

The automatic assignment of permissions to view a specific data domain is best done by selecting a 
primary data domain for a group or user. For more information, see How to assign a Primary data domain to a group 
or user.

2) Assignment of data domains to records.

The automatic assignment of data domains to records as a result of out-of-the-box business rules running in Service 
Management Automation X is the recommended best practice. Data domains can also be assigned to records 
manually in specific instances, but this is not recommended as maintenance and automation become much more 
complicated.

Use Case #1

Our Service Management Automation X system contains information pertaining to all aspects of our company’s day-
to-day operations. Some information in the system is considered confidential and should only be available to users 
that are part of certain groups. Specifically there are issues relevant to the IT department and the HR department that 
should only be visible to users in those respective departments. Additionally, some issues may be relevant to both 
departments. When an issue (request/incident/problem/change/etc.) is specified as an IT or HR issue, users that are 
not part of those groups should not be able to see the record.

Configuration Steps - Summary

1. Create data domains list and make them available for selection

2. Configure group and person forms with the primary domain field

3. Add a primary domain to roles, groups or users

4. Add default data domain to offerings

5. Create rules to add or remove data domains

http://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/Search.htm#search-assign%20a%20primary%20data%20domain%20to%20a%20group
http://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/Search.htm#search-assign%20a%20primary%20data%20domain%20to%20a%20group
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Configuration Steps - Detail

1. Create Data Domains list and make them available for selection

By default on all new Service Management Automation X tenants there is a single data domain named ‘Public.’ The 
public domain is the global domain that all users are members. Additional data domains are added through the list 
management menu. 

To add a new domain navigate to Administration -> List Management -> Data Domains. Select the list and then 
add the new data domain values to the list. Any values added to the list will be available for selection when 
configuration access. The data domain list is like any other list and values can be translated into any required 
languages. It is also important to plan any additions to the list carefully. Once a value is added to the list it may not be 
removed, and rendering rules must be added on every referencing form to hide specific values that are no longer 
desired.

For our use case we will add two domains to the data domains list: ‘HR’ and ‘IT’. These domains will be used as 
primary domains where applicable.

2. Configure group and person forms with the primary domain field

In order to be able to assign a primary domain to a group or person the field needs to be added to the default forms 
for the person and group record types. The data domains field is available on the roles form by default. 

To add the primary domain field to the group form, navigate to Administration -> Configuration -> Records and 
select the ‘Group’ entity. Under the forms select the ‘Full PersonGroup’ form. Click ‘Add field’ and add the ‘Primary 
Domain’ field and save. 

To add the field to the person form, navigate to Administration -> Configuration -> Records and select the ‘Person’ 
entity. Under the forms select the ‘Full Person form’. Click ‘Add field’ and add the ‘Primary Domain’ field and save.

It is also possible to directly add a data domain to an entity itself (request, change, incident etc). If this is the desired 
behavior, navigate to each of these entity types and add the ‘Data Domains’ field to the desired forms. 

3. Add a primary domain to Groups, Users or Roles

Each user or group only has a single primary domain, but data domains are cumulative for the user. Therefore they 
can belong to multiple data domains based on their group and role membership. 

To add the primary domain to a person, navigate to Administration > Master Data > People. Select the desired 
person and assign a data domain to the person in the ‘Primary Domain’ field,. The ‘Primary Domain’ field will allow 
any value that was specified as a Data domain in the first configuration step.

To add the primary domain to a group, navigate to Administration > Master Data > People > Groups. Select the 
group and assign the Domain using the ‘Primary Domain’ field,.

Users belonging to a group will inherit the primary domain assigned to the group. If users belong to multiple groups 
they will inherit from all of their groups. To add the primary domain to a group, navigate to the Administration > 
Master Data > People > Groups.

Data domains can be added to roles by using the ‘Data Domain’ field. You may specify multiple domains for each 
role. To assign domains, navigate to Administration > Master Data > People -> Roles. Select the desired role and 
assign the domains required in the ‘Data Domains’ field.

Domains are most often added to groups when referencing specific tickets (incidents/requests/changes/etc.). Adding 
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domains to roles works well to control the data available in specific views and/or reports.

For this specific use case all IT groups would have primary domain of ‘IT’ and the HR groups would have a primary 
domain of ‘HR’. 

4. Add default data domain to Offerings

In many cases a desired behavior is to automatically assign a request to a certain domain based on the selected 
offering. Data domains can be assigned by adding a group into one of the group fields in the ‘Default values’ tab of 
the offering. Navigate to Service Catalog -> Offering -> <Select the Offering> -> Default Values -> Add a Group 
that has a primary domain assigned and configured in a previous step. All requests opened with this offering will 
automatically be assigned to the configured group which will in turn automatically assign the data domain.

When end users create requests and select an offering, the request will automatically be assigned to the service desk 
group and the data domain applied so only those members of the domain can view them. If no primary domain exists 
on a group and a request assigned to it then the request remains public and anyone can view the request. 

For this specific use case we review all offerings and assign the default service desk group appropriately — being 
sure to assign HR offerings to an HR group and IT offerings to an IT group.

If a HR request needs interaction by IT the service desk group would be set to an IT group, at which time the data 
domain for IT will be added to the specific request. In this case both the IT and HR groups may view the request.

5. Create rules to add or remove data domains

In some cases it is preferable to use business rules to add domains based on information in the current record (such 
as category or business service). In order to accomplish this, business rules can be added to append or remove 
domains based on specified conditions. 

Note that using the ‘Set field’ rule type on data domains will do a full REMOVE and then ADD of the new value. Only 
use the ‘Set field’ if you want remove any existing domains and only have the value in the set field. To append values 
or remove a specific value, use the ‘Append or remove values in a multi-value field’ rule type.

To add the new owner’s primary data domain to an entity (if they have one defined):

If ${current_update.OwnedByPerson.IsChanged && 
current_update.OwnedByPerson.NewValue != null && 
current_update.OwnedByPerson.NewValue.PrimaryDataDomain != null}

Append to multi-value field Data domains the following values $
{entity.OwnedByPerson.PrimaryDataDomain}

It is also necessary to remove the ‘Public’ group if it had previously been set. Otherwise everyone will still be able to 
view the record:
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If ${current_update.OwnedByPerson.IsChanged && 
current_update.OwnedByPerson.NewValue != null && 
current_update.OwnedByPerson.NewValue.PrimaryDataDomain != null}

Remove multi-value field Data domains the following values 

Public
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Use Case #2
Company ABC uses multiple contracting companies to maintain their network infrastructure. Each of the contracting 
companies have several onsite members who are assigned the various tasks. Company ABC wants to create a task 
plan that will allow it to assign tasks to each of these contracting companies while prohibiting them from viewing the 
details of the change itself or any of the tasks assigned to other contracting companies.

Configuration Steps - Summary

1. Create data domains for each of the contracting companies

2. Create and configure groups for each of the contracting companies

3. Create a task plan in the change

Configuration Steps - Detail

1. Create Data Domains for each of the contracting companies

Navigate to the Administration->Lists form and find the ‘Data Domains’ list. Add a new entry for each of the 
contracting companies. In this use case entries for Contractors A.B and C will be added.

2. Create groups for each of the contracting companies

Each of the contracting companies requires a group that contains the onsite contractors. In this use case, groups 
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named Contractor A, B, and C will be added. The users belonging to the contracting companies will be added to the 
appropriate groups.

After creating the groups, the data domain added in the first step needs to be added as the ‘Primary Domain’ for each 
group. In the example below the “Contractor A” domain is assigned to the Contractor A group.

After adding the primary domain to the group, add the users belonging to Contractor A, B or C to the corresponding 
groups.

3. Create a task plan in the change

Create a new normal change and assign it to the change manager group. In this use case the change manager group 
has its own data domain named ‘Change Managers’, and only members of this group can view the change. None of 
the contractors have rights to access entities assigned to the ‘Change Manager’ data domain. In the change, click on 
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the plan and execute tab and then add a new manual task and assign it to the Contractor A group.

When the change manager group user views the change the task plan appears with the 3 tasks (below).

The data domain column (screenshot below) lists the domain set for each task. In order to view the task, the user 
needs to be a member of the data domain set for the task. Contractor B will not have permission to view the 
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Contractor A and C tasks. The change manager group is not able to view the tasks since the change manager 
domain is not assigned to the task. 

If the use case requires that the change manager group be able to view the tasks in the various data domains the 
best practice is to use the multi-select field for the data domain field available in the roles. Create a role and assign all 
the required data domains to it. Apply the role to the person or the group and then the user would have rights to view 
the data domains that are set.
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In this example the task plan is added to the change itself. If it is common to assign tasks to multiple groups, creating 
a task plan in a change model would save time when creating new changes. The model would then be applied to the 
change automatically, thus creating the task plan.
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Configuring Business Intelligence Synchronization

Introduction

The Business Intelligence (BI Sync) Integration module enables you to define the fields and relationships that are 
synced for a record type when integrating with an external business intelligence system. This can help you export 
your data to a third party system with different reporting tools. BI Sync exports additional information not currently 
available in the SMA-X reporting framework. 

IMPORTANT NOTE:

Business Intelligence Synchronization is a resource intensive feature, this document describes the specific 
use case of exporting people and groups to excel using BI Sync so they can be grouped and reported on. BI 
Sync does not have the ability to have two sets of configuration. While it might be acceptable to run an initial 
sync more than once with low volume entities like people/groups, it would not be a good idea with large 
volume entities like request/incident. There is also a monthly quota per tenant that will get used rapidly if a 
large number of entities are exported consistently. 

Use Case

A company named ABC Reporting wants a report that lists all the users and all of the groups they belong to using 
Microsoft Excel.

Data required selecting in BI Sync to report on groups and group membership:

● Person-> Id, Name, Group members.

● Group->Id, Name.

Configuration Steps - Summary

1. Add the record types and fields required to generate the desired reports

2. Execute the REST call in order to generate and download the data

3. Load the data into Microsoft Excel
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Configuration Steps - Detail

1. Add the record types and fields required to generate the desired reports

BI Sync allows users to export all transactional data available in Service Management Automation X. Select an entity 
type from the record type list. Select all the fields that are required, note when the fields are dependent on other entity 
types an indicator is next to the field name. All of these entity types will also need selecting. If related records are 
required these also need to be included.

Fields required for Groups entity:

Fields required for Person entity:
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Click save.

2. Execute the REST call in order to generate and download the data

While logged into SMA-X, open a new tab in the browser and launch the Postman Chrome extension. 

Execute the REST call to run the BI sync job:



Configuration Guide

54

Using the SyncId from the above call, execute the REST call to get the status and the file names created by BI Sync:
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There will be a number of files, record the names of all of the files, open another tab in the browser and enter the 
URL:

https://msast002pngx.domain.com/rest/<TenantID>/frs/file-list/<FILEID>

A file download will start and a file in the format <Entity_type>.zip, repeat for each of the FileID values obtained in the 
status REST call. 

3. Load the data into Microsoft Excel

There should be at least 3 files in total after downloading all the files:
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Open each of the files and save them as Excel files. Open the file that stores the relationships between the people 
and groups, the file is named ‘PersonToGroup’.

Add two new columns Group Name and Person Name after the SecondEntity_PersonGroup column. In the Group 
Name field paste the formula =VLOOKUP(D2,PersonGroup_0!C$2:D$800,2,FALSE) when you save the formula a 
file selector will open. Select the Person_group_0.xlsx file created above.

In the Person Name field paste the formula =VLOOKUP(C2, Person_0!C$2:D$800,2,FALSE) into the field and 
select the Person_0.xlsx file when the file selector window opens.

Note that the “800” in the above formulas can be replaced with the total number of rows in the referenced 
spreadsheet.

In excel it should look like the following:

Copy the formula for the columns E and F for all entries and add a filter to the top row. It is now possible to filter on 
group or person and see all of the associated values.
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Using Power BI to Create Reports

Introduction

Service Management Automation-X includes a BI sync feature that allows users to download entity data and 
relationships in order to create reports in external tools. Microsoft Power BI is able to use the data exported from 
Service Management Automation-X to generate customized reports. This document describes how to use the data 
created by the sync process to create reports in Power BI.

Use Case

Company ABC wants to create a report that will list Requests with their SLT next target time as well as the target 
status. The report must allow the ability to filter by offering, service or assignment group.

Configuration Steps - Summary

1. Add the record types and fields required to be able to generate the desired reports 

2. Execute the REST call to generate data

3. Download the data

4. Import the data into Power BI

5. Add display names for the service, group and offering

6. Refresh the data

7. Load and combine multiple files
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Configuration Steps - Detail

1. Add the record types and fields required to be able to generate the desired reports 

BI Sync allows users to export all transactional data available in Service Management Automation-X. In the BI 
interface select the Actual Service, Agreement, Group, Offering, Record Target Status and Request.

To include the offering, group and service, the record types need to be selected. Inside most types, select the id and 
displaylabel fields. For the group type, select the Id and name field.

 

The record target status requires a number of fields.

 

Any additional fields that are needed for the reports can be added to the Request export. In this case not all are 
selected, but the id is required. 

 

2. Execute the REST call to generate data

After selecting the entity types and fields that are required, the administrator must execute the REST call to run a 
scheduled job that prepares the data. It may take several hours before the data is ready for download. To start the 
job, execute the following REST call: https://$testmachineandport/rest/$tenantId/bi/initial. This will perform a full 
synchronization of the data. If you have already downloaded a full sync of data, it is possible to run a job that will only 
generate the differences (changes) since running the last initial sync. When the REST call is run, it will provide a Sync 
Id. The Sync Id is used to identify when the job is done and where the resulting files are stored. This document only 
examines the full sync process.

3. Download the data
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Run the REST call: https://$testmachineandport/rest/$tenantId/bi/status/<syncId> in order to see if the job has 
completed.

If the job has completed, the result of the REST call will include "Status": "COMPLETE". When complete, there will be 
a ‘files’ section in the result that lists all the Ids of the files that were created during the export. The files are 
compressed in Zip format. All files must be downloaded. If this process will be run often, it is suggested to create an 
automated script to run the procedure. 

The files are named using the format: "FileId": "4743431f-6c4b-4f24-87b8-bfe15721da97". To download the file from 
the browser, assuming you are logged into the Service Management Automation-X UI, use the URL: https://
$testmachineandport/rest/$tenantId/frs/file-list/<FileID>.

4. Import the data into Power BI

From the ‘Get data’ button select the ‘text\CSV’ option.

The files will appear similar to the list below. Select each file one by one. If prompted, accept any default value and 
click the ‘load’ button.

 Once all the data is loaded the various files should appear along the side panel.

https://$testmachineandport/rest/$tenantId/frs/file-list/%3CFileID%3E
https://$testmachineandport/rest/$tenantId/frs/file-list/%3CFileID%3E
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Once loaded, select the ‘Request’ file. Then select all of the fields needed in the report. 

 

When the value in the field is an Id, make sure that the field is not being counted. Otherwise, the value ‘1’ will appear 
in all rows. To correct this behavior, select the field from under ‘values’ and change ‘count’ to ‘Don’t summarize’.

 

5. Add display names for the service, group and offering

Select the Actual Service_0 file and expand the list of fields. Select the DisplayLabel field, and the ‘fix this’ dialog will 
appear. Click on ‘Fix this’ and select ‘create relationship’.
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Select Request from the dropdown, then select the RegisteredForActualService column. On the bottom dropdown 
select ActualService, then select the Id column and click ‘ok’.

Navigate back to the field view. In the main view the DisplayLabel of the service will now appear in the list.
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Repeat the same procedure to make the offering DisplayLabel appear.

Select Request from top dropdown and the RequestsOffering column. On the bottom this time, select the Offering Id 
column.

 

The DisplayLabel of the offering will now appear. To rearrange columns, drag the field names in the ‘values’ list (on 
right) to where they need to appear. 
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Repeat once again for the group.

The following shows how to ad the service level target information. In this example the status and the target time 
fields are used.
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When the target date time has been added, it will appear in a unix timestamp format. To change this into a readable 
date format, there are a few steps involved. Select ‘edit queries’ from the edit queries dropdown in the menu bar.

When the editor opens, select the add column menu and select the custom column.
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Create the new column. Add the formula “if[TargetDate]=null then null else #datetime(1970, 1, 1, 0, 0, 0) + 
#duration(0, 0, 0, [TargetDate]/1000)”. This formula creates a readable date format.



Configuration Guide

67

Click on the column header, then select the Data Type dropdown. Select Date/Time, then save the window.

The newly created readable time field is now selectable and will show the date in readable format.
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Filters can now be applied to display the results required. As an example, a filter on the offering “Demo Repair my PC 
hardware” will only show those requests, including the next target time (if exists) and status (which would indicate 
achieved or breached). Similar filters can be applied to the service or assignment group.

6. Refresh the data

When using the full sync option in BI sync, it is possible to use the same Power BI configuration and load new data 
when it is available. You must use the same directory and naming convention used when the Power Bi configuration 
and import was initially performed. After the new data is copied into the folder the data was loaded into, import it into 
Power BI by right clicking on each of the csv files and clicking ‘refresh’ to get the updates.
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 From inside Power BI, click on every file and select refresh.

7. Load and combine multiple files

On systems that have a large amount of data, BI sync will create files in the format Request_0.csv, Request_1.csv, 
Request_2.csv etc. Power BI is able to combine the data into a single table using a few extra steps. Power BI is able 
to combine files located in the same directory. Create a directory named “Request” (for this example) and put the files 
into this folder.
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In this example there are 3 Request files that need to be combined.

 

Click on the ‘get data’ button, then click ‘connect’. Select the folder that has the Request files in it and click ok.

 Select the folder that contains the files and click ok.

Click the ‘combine’ button and select the ‘combine and load’ option.

Click on the ok button, and the files will be loaded.
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When the files load, the Requests panel on the side will contain information from all of the files. The links between the 
entities are handled the same way as they are with a single file.
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Using Offerings to Create/Update Person Records

Introduction

In Service Management Automation-X it is not possible for an agent to create or modify person information without 
the having the tenant admin role. In some cases system administrators do not want agents to have the tenant admin 
role but they still want the agent to be able to create or modify a Person. By using offerings it is also possible to allow 
self-service users themselves to update profile information not otherwise available. Using offerings is an option that 
would allow a non-tenant admin user to be able to perform these actions. 

Use Case

Company ABC want to allow agents who do not possess the tenant admin role to be able to create or modify contact 
information. Company ABC wants self-service users to be able to modify a few fields on their own profiles. Company 
ABC plans on using two offerings in order to satisfy the requirement. Company ABC will use an audience to limit 
users who are able to create accounts, while all self-service users can update their own profile information.

Configuration Steps - Summary

1. Create an offering to create contacts

2. Create user options to define the fields to be populated

3. Create a task plan to use the user options to populate the contact information

4. Assign entitlement rules to the offering.

5. Create an offering to modify users

6. Create user options to define the fields to be updated

7. Create a task plan to use the user options to modify the information
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Configuration Steps - Detail

1. Create an offering to create contacts

In the Service Catalog create a new offering named “Create new Contact.” The offering will be a service offering.

2. Create user options to define the fields to be populated

Click on the User options tab of the offering created in the previous step. Create a user option for each of the fields 
that need to be populated for the contact in the Person record. Note that Service Management Automation-X has 
several required fields when creating a contact (Name, Email and User principal name). Make sure to check the 
required attribute when the field is mandatory.
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3. Create task plan in the offering to populate the new contact fields with user options

Click on the task plan tab, then create a new automated task in the fulfill phase (assuming no approvals are needed).

Add a business rule to the task that will create a record and set the record type to “Person”.

  

Add the fields in the Person record that need populated (click fx button to add expression) and add the names of the 
matching user options created in the previous steps. 



Configuration Guide

75

 

When the request is created, select the offering and populate the fields with the contact details. When the solution 
and completion code are populated, the Request moves into the fulfill phase and the task plan will run and create the 
contact.

 

**Optionally, if it’s required that no manual intervention should occur when an end user creates a contact, a rule can 
be added to populate the solution and completion code fields.  When these fields are automatically populated the 
Request will move straight from the log phase to accept phase after the contact is added. This would be the same for 
the update user information offering.
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4. Assigning entitlement rules to the offering

The last step of the creation is to use the audience field in the offering to add an entitlement for only those users who 
are agents. This stops self-service portal users from being able to see the offering. The audience can be assigned 
based on roles so that only some self-service portal users can see the offerings. A new role name “Contact Creators” 
would be created and only select users will be added to it.

5. Create an offering to modify contact\user information

Create an offering that will allow the agent to modify and existing contact or user. The offering will be a service 
offering and will use user options and a task plan to do the updates. In this offering people who are contacts OR 
users can be updated. A person is only considered a user if they have an account in the System Administration portal 
and are able to login to Service Management Automation-X.
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6. Create user options in the offering 

Click on the user options tab and add the user options that will be updated by the request.

7. Create task plan in the offering to update the fields

The System Administration portal runs a sync every night that will update any changes to the Phone Number or 
Name of users, so these fields shouldn’t be modified. Contacts are not updated by the sync so most fields can be 
updated. Also note that the UPN field cannot be changed after the contact or user is created. The task plan needs to 
use a decision to see if the user option has been populated so it does not save an empty value into the person record 
overwriting what is already there. Once completed the task plan will look similar to the example below. Add the task 
plan to the fulfill tab (unless an approval is desired).
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Create a new decision for First name, and add the check to see if the user option is populated, the expression is $
{entity.UserOptions.FirstName_c!=null}. If the field is populated then it will proceed through the Yes path onto the 
automated task to populate the field in the person record.

Under the “yes” side of the decision add a new automatic task. Select the “set field on related record rule” type and 
then set the record type to “Person” with Ids of “entity.RequestForPerson.Id”. The flow of the offering will be that 
whoever is selected in Requested For Person will be the user who gets the information updated(other person fields 
could be used).
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In the “set” section, add the first field that needs to be updated with the user options created in the previous step. A 
separate task needs to be added for every field to see if they are empty or not.

Use the “Path to” option to then join the “no” path onto the next field check because no operation is needed when the 
decisions moves through no.

Finish by using the join option to create an end node for the task plan to finish on.
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Use entitlements to allow self-service users to see the offering, when they update the fields their own profiles will be 
updated.
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Configuration of the LDAP -> Service 
Management Automation X integration

Introduction
An out of box configurable integration is available that imports contacts into Service Management Automation X. The 
integration is configured in the Service Management Automation X UI and uses the on premise bridge to connect to 
an Active Directory or LDAP compatible server. It can either create new contacts or update existing contacts based 
on a matching UPN. The integration only pulls information from the active directory server, updates made to Service 
Management Automation X users are not pushed back. There are configurable filters to control which users are 
imported based on criteria set in their profile. 

Use Case
Company ABC is using Microsoft Active Directory 2008 to manage their users. Company ABC wants to use the LDAP 
integration to import some of their users as contacts into Service Management Automation X. Only those Active 
Directory members who are currently active users and are in the MyCompany OU need to be imported. All other 
Active Directory members will not be imported. 

Company ABC wants to import the following fields:

• First and Last name
• Email Address
• UID(unique identifier)
• User Status
• Location
• Manager
• Hire Date
• Home Phone number
• Mobile phone number

Text fields will directly populate values during the import from Active Directory to Service Management Automation X. 
When the fields that are being imported are list values (location, cost center) or a manager then a special mapping 
process occurs. It is important to note that if any customized workflow rules or mandatory fields have been added to 
Service Management Automation X the fields used during the import must satisfy those conditions or the contact may 
not be imported.

Steps to Implement
1. Confirm the Active Directory is a supported version
2. Download and install the On Premise Bridge
3. Confirm the credentials of an account capable of viewing the Active Directory 
4. Determine which fields in Active Directory are needed and match the appropriate fields in Service 

Management Automation X
5. Add the Active Directory connection credentials to the OPB
6. Add and configure the endpoint to Service Management Automation X
7. Run the full sync to import the contacts
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1 — Confirm the version of Active Directory is supported

The Service Management Automation X integration does not support all AD\LDAP distributions. Consult the capability 
matrix located in the Service Management Automation X on-line help to confirm your version is supported. As of 
August 2016 only Microsoft Active Directory 2008 and 2012 as well as ApacheDS 2.0 are supported.

2 — Download and installing the On Premise Bridge

You must install the On Premise Bridge on a machine that has access to both the Active Directory server and the 
Service Management Automation X tenant at all times. HPE recommends against installing the agent on laptops or 
machines that are not actively maintained for consistent uptime. The firewall on the machine must allow the agent to 
connect to ports 10389 or 389 (the default LDAP ports) and also to the tenant on port 443.

There are two steps to installing the On Premise Bridge. First, download the OPB connection file. Second, download 
the installation binary (covered in the next section). To download the OPB connection file, open the Service 
Management Automation X UI and then navigate to Admin-> integration->Agents. Click on the ‘Add agent’ button to 
launch the new agent form. Enter a name for the agent and then click on the ‘Download Connection File’ button. 
Once clicked, a file with the information on how to connect to this specific tenant will be downloaded. The connection 
file is unique per tenant and has information including the agent name, tenant number and farm location. After 
downloading the file, it will need copying to the machine where the OPB will be installed. The configuration file is 
named serverconnection.conf.

The On Premise Bridge agent installation is available for download from the Service Management Automation X UI 
on the Admin -> Integration Management -> Agents page. Then click on the ‘Download agent’ button. The agent is 
~200mb in size and may require several minutes to download. The file is named opb-installation.exe

https://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/1700_Admin/pplLDAP.htm
https://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/1700_Admin/pplLDAP.htm
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Copy the installation binary downloaded in the previous step to the machine that it will be installed on and double 
click to launch.

The user name and password in the ‘Setup authentication’ form is the account used to login to Service Management 
Automation X. The user name combined with the OPB configuration file tells the agent how to connect to the Service 
Management Automation X tenant.
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Click the install button to complete the installation. 
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To complete the configuration of the agent, copy the ‘server-connection.conf’ file downloaded in the previous step to 
the conf folder of the OPB (by default located in the C:\Program Files\HP\On-Premise Bridge 
Agent\product\confdirector). Once copied, start the On-Premise Bridge service (this service is not started by default 
after the installation).
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Confirm that the agent has been configured correctly by bringing up the Service Management Automation X 
Integration page and clicking on the agent just created. Confirm that the status is ‘Success’. If it did not connect 
successfully, try restarting the agent. If restarting does not correct the issue, consult the controller log located in the 
C:\Program Files\HP\On-Premise Bridge Agent\product\log\controller directory for more information on connection 
issues.

3 — Confirm the credentials of an account capable of viewing the active directory 

Login to a machine using the credentials that should be able to connect to the Active directory and confirm that you 
can see users or groups. Most importantly make sure that the OU intended to be imported is visible. Below the Active 
Directory administration tool on a Windows 2008 Server is showing the user account named “Stone Smith” that exists 
inside the MyCompany OU.
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There are a number of 3rd party tools that can be used to view an Active Directory that may make finding the fields 
that need to be mapped to Service Management Automation X easier. Below is an example of one of the free tools 
distributed by Microsoft named the Active Directory Explorer available for download on the Microsoft website. In the 
active directory explorer the names of the attributes are all visible with the value set for them in each entry. In the 
example the OU=MyCompany is visible, all users in any of the OUs under will be imported if they match the import 
criteria defined in the endpoint.

https://technet.microsoft.com/en-us/sysinternals/bb963907.aspx
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4 — Determine which fields in Active Directory are needed and match them in Service 
Management Automation X

The names of attributes in Active Directory may or may not match the name of the field in Service Management 
Automation X. In many cases the field names will be different and need to be mapped when configuring the 
integration. In the screenshot above note the AD sn attribute, in Service Management Automation X the equivalent 
field would be the ‘LastName’ field. Best practice is to make a chart like below to confirm all the fields and names are 
known.

Name Active Directory attribute name Service Management Automation X 
field name

First Name givenName FirstName
Last Name Sn LastName
Email Address mail Email
Unique Account Identifier userPrincipalName Upn
Status userAccountControl Person Status
Location l (But sometimes co ) Location
Manager manager Manager
Internal hire Date whenCreated HireDate_c – (Custom field)
Phone Number homePhone HomePhoneNumber
Mobile Phone Number mobile MobilePhoneNumber

The userAccountControl field has a number of values that need to be mapped to fit into the Service Management 
Automation X status field. This field contains the current user account status and is needed to determine which 
accounts are Active and which are InActive. Active Directory uses a number of decimal values to indicate active 
accounts in various states. In this example we’ll use ‘0’, ‘512’ and ‘66048’ as valid decimal values for active accounts. 
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Note – Service Management Automation X changes all userAccountControl values to either a ‘0’ or a ‘2’.  Zero is the 
value for active account no matter what the value is in AD.  Two is the status value no matter what the inactive value 
in AD.

5 — Add the Active Directory connection credentials to the OPB

The login required for access to Active directory needs to be added to the OPB. On the machine where the OPB is 
installed launch the Endpoint credentials manager from the Start menu.

Add a new OPB LDAP Domain connection with the login to active directory
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6 — Add and configure the endpoint to Service Management Automation X

Navigate to the Admin -> Integration -> Endpoint page and click ‘Add’ to create a new endpoint.

Select the LDAP integration option from the type dropdown, add a name and then select the agent where the Active 
directory credentials were added. In this case the agent is named LdapTest and the endpoint is named Active 
Directory. After clicking add, click on the ‘Configure’ button to configure the endpoint
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Connection Configuration

After clicking configure on the endpoint add the hostname or IP address of the Active directory server. The default 
active directory port is 389 but in some cases it may be 10389. If the defaults do not work consult the person who 
manages the active directory server. If the AD server is using SSL a certificate may be required, instructions for 
importing the certificate into the OPB are described in another section of the document. The AD credentials added in 
the previous step should be visible and selectable from the dropdown. The scheduled integration interval is the 
frequency that the data is pulled from the active directory server. The default is a once a day schedule which is 
normally sufficient, the frequency can be increased if required. It’s also possible to run the sync adhoc with the press 
of a button.

Integration Configuration

Select the LDAP server type, in this use case the ‘Microsoft active Directory 2008’ value is selected. The starting 
search directory is an important parameter that determines where in the tree the integration will start to pull contacts 
from. Enter the DN of the highest level in the tree desired to be imported. Click the ‘Test connection’ button to confirm 
the settings are working.

In the Active directory Administrative Center this can be seen by highlighting the OU. In the example below the DN is 
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‘OU=MyCompany,DC=oxygent,DC=com’. In this example only entries below this will be imported.

 

The Active Directory explorer tool also displays the DN(distinguishedName).

Record to record mapping

The target record refers to the Service Management Automation X record type, in this case person. The source 
record refers to the person objectClass in AD. The additional filtered parameter is filtering the person record if it does 
not contain the value 0,512 or 66048 in the userAccountControl attribute. If the objectClass of the AD entry does not 
match the filter the user is not imported 

Syntax for the filter is (&(objectClass=person)(|(userAccountControl=512)(userAccountControl=0)
(userAccountControl=66048)))

In the active directory explorer the objectClass is visible on the person entry. There can be multiple objectClasses on 
an entry, below there are multiple including person and also organziationalPerson – either could have been used but 
in this case person was used.
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Target field configuration

Text fields need to be mapped by selecting the target field name and then entering the source field. Example below 
shows the first name field mapped to the givenName source field. No DSL is needed because the text from source is 
just added to the target. In Service Management Automation X the ‘Name’ field is generate from the first name and 
last name fields, it would have also been possible to import the name field as well but it is not necessary. 

The list of fields in the use case would appear as:

There are a number of DSL functions that will find, convert or map data to the correct format. Examples of this are 
included above for importing the location, manager, person status and hire dates.

In order to populate the location in Service Management Automation X the location in the user’s Active Directory 
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profile needs to match a value in the Service Management Automation X location list. In this example the ‘l’ attribute 
in Active Directory is storing the name of the city that the user is located. 

Using a DSL expression we can look up the matching Service Management Automation X Location and populate the 
field. The source field expression is written as the following: ${identification.findBy('Location', 'Name', source.l)} where 
the AD attribute “l” is referenced with source.”l”. If there was another field such as an AD field named “city” that stored 
the location the syntax would be “source.city” instead of “source.l”. Make sure to click the FX box so that it is green to 
indicate an expression is being used.

In the expression, the location is referring to the location entity and the ‘Name’ is referring to the Name of the location 
(San Diego).

To populate a date the format of the source date needs to be included in the DSL. Dates stored in AD appear in the 
format yyyyMMddHHmmSS (in the active directory explorer it is interpreted and displayed in a friendly manner). The 
name of the attribute that needs to be imported is whenCreated so the rule would appear as $
{to_date_time(source.whenCreated,'yyyyMMddHHmmss')}. 
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When a manager is assigned to a user in Active Directory the manager’s full DN is stored in the manager field.

The source field for the manager would appear as ${external://'person'/source.manager}. Service Management 
Automation X is able to match the DN stored in AD to the Service Management Automation X user and correctly link 
the manager. Quotes are needed around the “person”, person is referring to the objectClass of the entry in AD.

When the field in Service Management Automation X is a list, there is a mapping that needs to occur so the 
integration knows which field to link to which. In this example a variety of values are linked to the ‘Active’ status in 
Service Management Automation X. Any similar list in Service Management Automation X needs the same kind of 
mapping. Since userAccountControl is always converted to a 0 or 2 the mapping looks like below.
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7 — Run the full sync to import the contacts

Click on the ‘Request full sync’ button to perform the initial sync. This will import all AD users matching the filter and 
criteria into Service Management Automation X as contacts. If the user does not currently exist in Service 
Management Automation X a new contact will be added. If a contact OR user already exists in Service Management 
Automation X with a matching UID, the information in Service Management Automation X is updated to reflect the 
data pulled in from AD. Contacts who are made users will continue to be updated when a sync with AD occurs. 

When the job runs it will add a status to the grid, by clicking on the ID it is possible to review the details of the import.

If there are problems error messages will appear indicating the issue. In the example below the last name field was 
not added because there was an issue with the mappings. Once the mappings are correctly the sync can be run 
again.
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If the desire is just an incremental sync (only changes since the last sync), it is possible to click on the sync button.
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Configuring Service Management 
Automation for High Availability

Introduction
In order to support mission critical systems, the Service Management Automation suite (SMA) is capable of running in 
a High Availability (HA) configuration. When running in HA mode, SMA is able to maintain end user connections if the 
master or worker nodes become inactive. To run in HA mode, additional resources are required beyond the minimum 
resources in the sizing guides. Please note that the recommendations in this section do not cover the NFS and 
database implementations.

Use Case
Company ABC wants to implement HA for their SMA instance. They will be using the fully containerized SMA mode 
and use Service Management, the Service Portal, UCMDB, Smart Analytics, and chat. Company ABC estimates that 
they will have no more than 400 concurrent Service Portal or Agents using the system at any time. 

Steps to Implement
1. Determine the appropriate hardware resources
2. Prepare the environment for installation
3. Obtain the virtual IP and DNS name
4. Install the first master node
5. Install the second master node
6. Install the third master node
7. Test that the master nodes are working together
8. Deploy the worker nodes
9. Upload the SMA images to master 1
10. Install SMA suite

1 — Determine the appropriate hardware resources

The sizing guide is available on the help center and recommends the minimum hardware required to run the SMA 
suite based on the concurrent user count. The sizing guide is available here for the Service Manager version of SMA. 
Company ABC concludes that since they will not exceed 500 concurrent users that they will use the Medium 
installation configuration.

 

Production installations require an external NFS server and database servers. The NFS and databases need to be 
configured according to the internal IT policies of the customers that provide an HA environment. The process will be 
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transparent to the SMA installation.

The HA configuration requires an additional 2 Master nodes so 3 in total. In all there will be 11 images for the SMA 
installation as well as the database and NFS servers.

It is important to note that the number of master nodes cannot be changed after the system is fully installed. The 
desired number of master nodes must be determined and installed before the worker nodes are added.

2 — Prepare the environment for installation

A number of pre-requisites required on the master and worker nodes are listed on the help center here. It is important 
to not miss the step that creates the no_proxy environment variable on each machine.

3 — Obtain the Virtual IP address

When using HA mode with multiple master nodes, a static IP and DNS name are required. The IP will not be assigned 
to any specific machine. Instead, the IP address will be used as a virtual IP and will be managed by the three master 
nodes. If any node goes down, end users will not experience an interruption in their connection. The embedded 
technology of the master nodes manages the IP address, and no additional network configuration is required. It is 
recommended that the Master IP addresses and the IP address used as the virtual be on the same subnet.

4 — Install the first master node

Assuming the pre-requisites and the NFS partitions are created as defined in the help center, the first master node is 
ready to be installed. To install the master nodes, the following information is required:

• IP addresses of the 3 master nodes

• IP address of the virtual IP

• The external access Hostname — when using HA this is the DNS name assigned to the virtual IP address

• The NFS server IP and path

The information required for the first master nodes install.properties file is:

• MASTER_NODES="16.103.28.149 16.103.28.151 16.103.28.153"

• EXTERNAL_ACCESS_HOST=svssawha.hpeswlab.net

• HA_VIRTUAL_IP=16.103.28.1

• NFS_SERVER=16.103.28.149

• NFS_FOLDER=/var/vols/itom/core

• DEFAULT_DB_TYPE=EMBEDDED

It is best practice to install the worker nodes using the admin UI once the three master nodes have been configured. 

https://docs.microfocus.com/wiki/display/ITSMA201711X/Meet+the+prerequisites
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In this example we are using the embedded postgres for the CDF database. This is not the Service Manager 
database, but rather the database that the CDF uses to manage the master and worker nodes. In production mode, 
an external postgres database should be used. Instructions for using an external postgres are available in the help 
center.

After editing the ‘install.properties’ file with the above values and settings, the first master may be installed.

5 — Install the second master node

The process to install the second master node is essentially the same as the first master node with a few extra steps. 
After completing the pre-requisites and ensuring the no_proxy environment variable is set, copy the installation files 
to the second machine. From the /opt/kubernetes/ssl directory, copy the ‘ca.crt’, ‘server.crt’ and ‘server.key’ files to 
the /tmp directory so that the installation can use them while installing the node.

Edit the ‘install.properties’ file using the same parameters as the first master node, but add the additional three 
variables for the crt files:

• MASTER_NODES="16.103.28.149 16.103.28.151 16.103.28.153"

• EXTERNAL_ACCESS_HOST=svssawha.hpeswlab.net

• HA_VIRTUAL_IP=16.103.28.1

• NFS_SERVER=16.103.28.149

• NFS_FOLDER=/var/vols/itom/core

• DEFAULT_DB_TYPE=EMBEDDED

• PEER_CA_FILE=/tmp/ca.crt

• PEER_CERT_FILE=/tmp/server.crt

• PEER_KEY_FILE=/tmp/server.key

6 — Install the third master node

The process to install the third master node is the same as the 2nd master node. After completing the pre-requisites 
and ensuring the no_proxy environment variable is set, copy the installation files to the third machine. From the /opt/
kubernetes/ssl directory copy the ‘ca.crt’, ‘server.crt’ and ‘server.key’ files to the /tmp directory so that the installation 
can use them while installing the node.

Edit the ‘install.properties’ file using the same parameters as the first master node but add the additional three 
variables for the crt files:

• MASTER_NODES="16.103.28.149 16.103.28.151 16.103.28.153"

• EXTERNAL_ACCESS_HOST=svssawha.hpeswlab.net

• HA_VIRTUAL_IP=16.103.28.1

• NFS_SERVER=16.103.28.149

• NFS_FOLDER=/var/vols/itom/core

• DEFAULT_DB_TYPE=EMBEDDED

• PEER_CA_FILE=/tmp/ca.crt
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• PEER_CERT_FILE=/tmp/server.crt

• PEER_KEY_FILE=/tmp/server.key

7 — Test that the master nodes are working together

After the three master nodes have been installed and configured there are a few basic commands and tests that will 
confirm functionality. Use the command “kubectl get nodes –show-labels” to view the master nodes and confirm the 
three appear with the master=true parameter. 

Use the “kubectl get pods –all-namespaces –o wide” command to view that the pods are running on all three of the 
master nodes. There should be an apiserver, controller, kube-proxy etc for each of the masters.

8 — Deploy the worker nodes

Connect to the CDF UI using the URL https://<master_node_url>:5443/#/workload?namespace=core. Note that 
the external host access will be the DNS name of the virtual IP assigned to SMA. When clicking on administration-> 
nodes, the three master nodes will be visible.

After running through the pre-requisite list, deploy the worker nodes using the UI.
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When complete, the three master nodes and the newly added workers work should be listed.

9 — Upload SMA suite images to the first master node

The installation of SMA requires the SMA images to be downloaded from the Docker hub site and then uploaded to 
the local registry of the master node. The instructions for this can be found in the help center here . The SMA images 
need to be uploaded on the current active master node. The active master node can be determined by running 
“kubectl get pods –all-namespaces –o wide” and looking for the IP address or DNS name of the machine running the 
suite-db and suite-installer pods. The download images and upload images scripts described in the help should be 
run from this machine.

10 — Install SMA suite

Once these steps are completed, the SMA installation can be performed. 

https://docs.software.hpe.com/wiki/display/ITSMA201711X/Download+suite+images+from+Docker+Hub+to+CDF
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Importing Users into Service 
Management Automation X

Introduction

The process for importing person records into Service Management Automation X is a multi-step process. It involves 
adding people to both the Suite Administration portal and Service Management Automation X. The following outlines 
the procedure for configuring users in Service Management Automation X. 

This chapter will cover:

• Types of person records

• Determining how you plan on creating users and contacts

• Enabling the SSO integration between the Portal and Service Management Automation X

• LDAP integration

• Connect-it integration
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Types of Person records in Service Management Automation X
There are two types of Person records in Service Management Automation X: “Users” who are able to login to the 
Self-Service portal or the agent interface, and “Contacts” who are not able to login. Person records are automatically 
set to be users if there is an account in the Suite Administration portal that matches the UPN of the person in Service 
Management Automation X. The person is set as a contact if there is not a matching account. It is possible to switch a 
person record from a contact to a user by adding a user account to the Suite Administration portal with a matching 
UPN. Similarly, removing the user account from the Suite Administration portal changes the Person record from a 
contact to a user.

Determining how to create users and contacts
An important concept to understand is that for a user to be able to login to Service Management Automation X they 
need a record in two places. One record in the Suite Administration portal and another in Service Management 
Automation X. There is an automatic process that duplicates all users that exist in the Suite Administration portal into 
Service Management Automation X and make the matching UPN in SMA-X a user. The methods of creating users 
and contacts are outlined below.

Adding users manually through My Account in the portal

Users can be added and managed directly through the Suite Administration portal by clicking on the Users menu item 
and then selecting ‘New’. In this scenario the portal manages the accounts and passwords directly. The Email, First 
and Last Names, and Phone numbers are added to the Portal and pushed to Service Management Automation X. 
Additional attributes can be added through a person’s profile in the administration UI of Service Management 
Automation X. If the user is added to the Portal and a matching UPN exists in Service Management Automation X, 
the Service Management Automation X record would be switched from a contact into a user.

Manage Persons API

The Manage Persons REST API provides a way to create or update users and contacts on both the portal and in 
Service Management Automation X at the same time. The Manage Persons API can also populate user or contact 
attributes such as the location, organizational group, functional group and role (role can’t be changed using the other 
methods, but can be updated manually in the UI). A script needs to be generated in the format below that identifies 
the various attributes. The manage person API matches the name of the location and role and the UPN for the group. 
If one of the groups specified is an organizational group the user’s organization group is set with this value. If the 
Manage Persons API finds an existing account in the portal with the same UPN it will update that user, not create a 
new one. 

JSON Syntax to create a user:

https://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/8000_DeveloperGuide/ApiRESTUMS.htm
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JSON syntax to create a contact

Importing data from a CSV file

Contacts (Not users, so no account in the portal) can be imported directly into Service Management Automation X 
through the import data section of the Records->Person menu. By specifying the *.Name* next to the fieldname, 
locations and organizational groups can also be added (“Location.Name” for example) but unlike the Manage 
Persons API, the role can’t be added. Contacts do not have a record in the Suite Administration portal so they are 
unable to login to Service Management Automation X. If however a user is created in the Suite Administration portal, 
then the person would automatically be switched from a contact to a user. 
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Single Sign On (SSO)
An integration can be set up that will allow an Active Directory to control the user and password information of a 
Service Management Automation X user. When a user logs into Service Management Automation X SSO, a portal 
user will automatically be created based on the information that exists on the AD server for the Email, First and Last 
Names and Phone numbers. It’s also possible to create the user accounts using the other methods described above 
so that if the matching user information already exists in the portal or a contact exists in Service Management 
Automation X, that account would be used.

A best practice to consider is to pre-populate Service Management Automation X data for any person that may login 
using SSO. On first login if the information has already been populated any specific entitlements the user may have in 
the Self-Service Portal based on location or group membership will already be configured and the user will be able to 
see their offerings immediately. Similarly if the user has special rights defined by roles that provide additional access, 
if not pre-populated the user may have to open a request to grant them extra information.

LDAP Integration
An out of box configurable integration is available that imports contacts into Service Management Automation X from 
one of the supported LDAP versions. This integration is configured in the Service Management Automation X UI and 
uses the OPB (On Premise Bridge) to connect to LDAP. It will create new users or update existing users based on a 
matching UPN. There are configurable filters that allow the integration to determine which users are imported based 
on criteria set in their profile. 
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The integration also supports the selection of attributes to move from a user’s LDAP profile to Service Management 
Automation X. Any fields in LDAP can be configured to move to Service Management Automation X. The User 
principal name (UPN) is the unique value that Service Management Automation X uses for user reconciliation. If the 
UPN does not exist in Service Management Automation X a new user is created. if the User principal name exists the 
attributes for that user are updated.

Connect-It integration
Service Management Automation X can also make use of the Connect-It integration that is able to add users to 
Service Management Automation X by getting the information directly from an Active Directory. Information regarding 
using the integration can be found here.

http://community.hpe.com/t5/Service-Anywhere-Learn/Connect-It-support-for-SAW-Manage-Persons-API-through-new/td-p/6844821
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Configuring and Using the Postman 
REST Client

Introduction

Service Management Automation X allows users to access and modify data using a REST API. In order to use the 
REST API a REST tool needs to be configured. The Chrome web browser supports an extension named Postman, a 
commonly used REST utility. There are other REST utilities available, this document only describes one.

This chapter will cover:

• Installing the Chrome browser

• Adding the Postman browser extension

• Adding the Interceptor browser extension

• Finding the URL of the farm and tenant Id

• Sending commands

Installing the Chrome Browser
Postman is an available extension to the Chrome web browser. If you do not have Chrome currently installed, you 
may use another browser to visit this link: http://www.google.com/chrome/browser/. Follow the on-screen instructions 
in order to install Chrome.

Adding the Postman browser extension
Postman is a web extension available through the Chrome web store. To add Postman to the Chrome browser select 
Settings->Extensions->Get more extensions, then search for Postman. From the displayed application, click on 
the “Add to Chrome”button.

http://www.google.com/chrome/browser/
http://www.google.com/chrome/browser/
http://www.google.com/chrome/browser/
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In order to run Postman after it has been added, click on the Apps launcher within the Chrome application.

Then select the Postman icon from the list of installed extensions.

Adding the Interceptor extension to Postman
After launching the Postman extension, click on the interceptor icon seen below (in the red box). Toggle the 
Interceptor button to the on position.

 

When prompted, press the “Install” button to add the Postman Interceptor plugin.
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Finding the URL of the master node and Tenant ID
Each Service Management Automation X tenant is located on a specific server farm. You may identify the master 
node for your tenant by looking at the resource name in the URL you use to access it. The resource name is the part 
of the URL directly after the protocol identifier (usually http:// or https://).

The tenant id is found at the end of the URL, directly after the “TENANTID=” parameter. For example:

 

The name of the master node in the image above is msast002pngx.domain.com, and the tenant id is: 844143557.

Sending commands
In order to simplify the procedure of sending a REST call via the Postman REST client, use a standard browser 
session to login to your Service Management Automation X tenant. The Postman client will then use the same 
authorization information by sharing a browser cookie with that session. After logging into Service Management 
Automation X directly, open an additional tab in the Chrome browser to runt he Postman client in.

In the Postman client, enter the name of the master node and the tenant number in the address bar (in the example 
below the manage persons API address) is displayed. 

Click on the headers section and add the Content-Type and User-Agent headers with the values below (application/
json and Apache-HttpClient/4.4.1).

The REST API accepts 2 actions, GET and POST. Using a GET query will instruct the Service Management 
Automation X REST API to retrieve information and display it while a POST query will send information to be updated 
or added to Service Management Automation X. The URL information differs when performing either of these actions 
so it’s important to make sure the URL is set correctly in Postman before executing. Additional information on Get and 
Post can be found here.

In the example below, user information is being updated on a user so a POST action is selected (see the top left of 
the image).

Click on the ‘Body’ tab and add the REST information that needs to be sent to Service Management Automation X. 
Click the ‘Send’ button and the information is sent.

https://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol


Configuration Guide

112

If the desire is to display results, then a GET command would need to be used. The headers need to be set the same 
as before, but the URL and the action would be set to GET. No ‘Body’ needs to be set when retrieving information. 
Consult the documents on using the REST API to see examples of the possible REST endpoints that may be used to 
find or update information within Service Management Automation X.
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Accessing the EMS REST API using 
Postman

Introduction
Service Management Automation X includes multiple REST APIs that may be used to execute a variety of 
commands. This document describes using the Postman client to access the EMS REST API. EMS stands for Entity 
Management System, and is used to access and modify information for most record types in SMA-X, such as 
incidents, requests, services, and configuration items. 

Before using the information in this chapter it will be necessary to review the information found in the ‘Configuring and 
Using the Postman REST Client’ chapter of this guide. This chapter explains how to install the Postman client as well 
as how to find the master node and tenant Id for a specific Service Management Automation X instance.

This chapter will cover:

• Understanding the data structure of the API

• Determining the entity type and field names

• Handling specific field types

• Special considerations of the EMS API

• Retrieving information from Service Management Automation X

• Posting information to Service Management Automation X

• Determining entity type and field names

Understanding the data structure of the API
The Service Management Automation X EMS REST API uses the JSON data format to exchange data with a client. 
Information on the JSON format may be found here. 

If your intent is to use a tool such as Microsoft Excel to view the information returned from the REST API, you will 
need to convert the data returned from Service Management Automation X using some type of scripting or other data 
conversion process. There are a variety of conversion tools on the web that will transform JSON into CSV (or vice 
versa). You could use one of these tools to convert information in a spreadsheet to the JSON format required by the 
Service Management Automation X REST API.

An example of the JSON returned from the Service Management Automation X EMS REST API can be seen in the 
image below (please note that the image does not show the entire result returned by the API). The returned result is 
made up of multiple entities (records) from Service Management Automation X. In each returned record, the 
entity_type value specifies the type of record (in this example each entity is a ‘Request’). The properties section 
contains the attributes of the entity. The exact attributes returned are dependent on the query used to request the 
information. Finally, the related_properties shows information from other records that are linked to the requested 
entity. Again, the information included here is dependent on the initial request.

https://en.wikipedia.org/wiki/Representational_state_transfer
https://en.wikipedia.org/wiki/JSON
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When sending (posting) information to Service Management Automation X, the data format needs to be in the same 
JSON format. The following image is an example of how to create a Request in Service Management Automation X 
using the EMS REST API. The entity_type needs to be set to the desired record type, and when posting information 
you must also specify the type of operation (such as CREATE or UPDATE). In this example we set the operation to 
‘CREATE’ in order to create a new request. Attributes for our new Request are set in the properties section. To add 
more fields to the request, simply add the field name in quotes, a colon, and the value for the field (again in quotes). 
For example, to set a status you would add ‘Status’, the ‘:’, and then value ‘RequestStatusReady’. Each attribute 
must be separated with a comma, but there is no comma after the last specified attribute.

Determining the entity type and field names
All entity types can be updated using the EMS API (as long as you have a role that allows updating that specific entity 
type). In order to create or modify a specific field in an entity, you must know both the entity type and the field name. 
This information can be found in the Service Management Automation X interface. Navigate to the ‘Records’ utility 
(select Administration > Records from the main menu) and find the correct entity type using the field in the top left 
section of the form. The entity name displayed here is the correct entity type that is used in the REST request.
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The field name can be found in the ‘Fields’ tab of the entity definition. It is important to use the value in the “Name” 
column of the fields list and not the ‘Multilingual label’ column.

Handling specific field types
It is also important to note the logical type of the field in question. There are certain types of fields that need special 
consideration. These types (and how to use them correctly in the API) are defined below.

Enumerations

If the field in question has a Logical type of ‘ENUM’, which is an enumeration, you must pass the internal name of the 
enumeration value rather than the display name. To find the name, open the list in the List management interface, 
which will display both the internal name and display name of each list value. For example, in the list shown in the 
image below, the status value for ‘Ready’ would be ‘RequestStatusReady’.

The body of a REST request that would update the request with a status of ‘Ready’ is shown in the following image:

Entity links

If the field type is an entity_link (a link to a related entity/record) type field you must specify the unique id of the 
related record in the REST API (rather than any display name or value). Therefore you must determine what the id is 
and incorporating that value into the REST call. 

In the example below, the user wants to set the assignment group in a request to ‘Accounting’. To do this the user will 
first find the id of the accounting group and then set the ‘AssignedToGroup’ field in the request to the Id of the 
accounting group in the rest payload.

The id may be found by viewing the related record directly, or viewing a list that includes the related record. 
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Then the id is entered for the ‘AssignedToGroup’ attribute in the body of the REST request.

Date/time

If the field is a date or date_time you must specify the value using a Unix timestamp. Most scripting tools are capable 
of converting user friendly date/times to Unix timestamps. Additionally there are a number of on-line tools that can 
create these timestamps, including the one found here. Service Management Automation X requires that you define 
the timestamp down to the millisecond.

https://en.wikipedia.org/wiki/Unix_time
http://www.epochconverter.com/
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<Img:REST_6>

Special considerations of the EMS REST API
The EMS REST API has a few special considerations that must be followed:

• A query will fail if the result returns more than 4K records

• Results are returned in batches of 250 records at a time by default, which can be modified using the “size” 
parameter. Information on the skip parameter below.

• When querying for fields that are entity links, the id of the related record is returned (rather than the display 
label)

Retrieving information from Service Management Automation X
The EMS API can retrieve any information available to the entity grid (list of records) in the Service Management 
Automation X user interface. Parameters are available to the REST request that allow you to apply specific Filters to 
the query, as well as specify which fields should be included in the returned result. Results are returned in the JSON 
data format, so you may need to use scripting or some data conversion process in order to get the data in the desired 
format.

The following is an example of a ‘Get’ request that will retrieve results from Service Management Automation X. In the 
example the Id, DisplayLabel and Priority fields are being returned for request entities. 

The request URL is created as follows:

https://msast002pngx.domain.com/rest/844143557/ems/Request?layout=Id,DisplayLabel,Priority

The URL is created with the following information:

• https:// — specifies the protocol to use

• msast002pnqx.domain.com — the domain of the Service Management Automation X server master node 
which hosts the specific tenant

• rest — specifies the use of the REST API

• 844143557 — the tenant ID of the desired Service Management Automation X instance

• ems — specifies the use of the EMS REST API

• Request — The entity type

• ?layout=Id,DisplayLabel,Priority — specifies the comma delimited list of fields from the entity that should be 
included in the response (note that the LastUpdateTime field is always returned)
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The end of the query result will also return the number of records that matched the query, if the total count is more 
than 250, the skip command is required to display additional records after the first 250. In the example below the 
‘&skip=250’ parameter is added to retrieve the additional records. In cases where you expect more than 250 records 
to be returned, writing a script or code to process the queries and results is recommended.

The URL to skip the first 250 records of the query is:

https://msast002pngx.domain.com/rest/844143557/ems/Request?layout=Id,DisplayLabel,Priority&skip=250
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Filtering can be applied to any query sent through the REST API. The filter is specified as a parameter in the REST 
URL. In the example below, the results will be filtered based on the creation time of the entity using the parameter 
‘filter=CreateTime+btw+(1466406000000,1466492399999)’ (note the use of the Unix timestamp).

https://msast002pngx.domain.com/rest/844143557/ems/Request?
filter=CreateTime+btw+(1466406000000,1466492399999)&layout=Id,DisplayLabel,Priority

Posting information to Service Management Automation X
Any type of standard entity can be created or updated in Service Management Automation X using the EMS REST 
API. The URL to post data for all entity types is https://<master node>/rest/<tenantid>/ems/bulk. The type of entity 
being sent is defined in the entity_type field. In the example below a request will be created.

https://msast002pngx.saas.hp.com/rest/844143557/ems/bulk
https://msast002pngx.saas.hp.com/rest/844143557/ems/bulk
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To create an Incident the following payload would be used:

To update an existing record the same process is used, but the Id of the entity is required and the operation would be 
‘UPDATE’.
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To update an existing record by adding information to a field that is not currently populated just add the name of the 
field and value. Also note that multiple entities can be updated at the same time, as shown in the following example.
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Accessing the Manage Persons REST 
API using Postman

Introduction
Service Management Automation X provides REST APIs that can be used to execute a variety of commands. This 
chapter describes using the Manage Persons API, which allows you to create and update users in both Service 
Management Automation X and the Service Management Automation Service Portal.

Before reading this chapter you should review the following:

• Configuring and Using the Postman REST Client
• Importing Users into Service Management Automation X

This chapter will cover:

• The Manage Person API URL

• Configuring the upnDataType field

• Adding a Contact

• Updating a Contact

• Adding a User

• Updating a User

• Adding Groups to Users

• Adding Roles to Users

• Adding Licenses to Users

• Updating multiple Persons

Manage Person API URL
The Manage Person API URL uses the format https://<MasterNode>/rest/<tenantId>/ums/managePersons. To access 
the API using the PostmanREST client, set the action to ‘POST’ and enter the URL, then add the relevant information 
to the the body of the request.

https://en.wikipedia.org/wiki/Representational_state_transfer
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Configuring the upnDataType field
The Manage Person API uses the UPN field to identify person records. The UPN field is a unique identifier and is by 
default the email address of the person. In some cases this is not the desired behavior. If the email is not going to be 
the UPN then on every use of the Manage Person API to post data the upnDataType needs to be used. In the JSON 
payload the field name should appear as: "upnDataType":"Customer_UID" (see examples below)

Adding a Contact
When adding a person to Service Management Automation X, it is important to determine whether they should be 
added as a contact or a user. The difference is that a user has the right to log into the system whereas a contact does 
not. 

To add a contact, enter all desired attributes and then add the “IsMaasUser”: “false” flag. If IsMaasUser is not set to 
false the system will create a user instead of a contact.

{

"operation": "CREATE_OR_UPDATE",

"users": [{

"properties": {

"Upn": "MyNewUser@microfocus.com",

"Email":"MyNewUser@microfocus.com",

"FirstName":"My First Name",

"LastName":"My Last Name",

"Location":"London",

"IsMaasUser":"false",

"OfficePhoneNumber":"867-5309",

"EmployeeNumber": "4815162342"

}
}]

}
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The following image shows how the REST call to add a contact would be performed in the Postman client:

If you are using a custom UPN instead of the email address, the upnDataType information also needs to be sent:

{

"operation": "CREATE_OR_UPDATE",

"users": [{

"properties": {

"upnDataType":"Customer_UID",

"Upn": "MyLoginId",

"Email":"MyNewUser@microfocus.com",

"FirstName":"My First Name",

"LastName":"My Last Name",

"Location":"London",

"IsMaasUser":"false",

"OfficePhoneNumber":"867-5309",

"EmployeeNumber": "4815162342"

}

}]

}

Updating a Contact
To update a contact using the Manage Person API, simply create a REST payload with the desired attributes that also 
includes the UPN associated with the person. It is important to always include the "IsMaasUser":"false” flag when 
updating a contact or Service Management Automation X will attempt to convert the contact into a user.
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{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": "MyNewUser@microfocus.com",
"IsMaasUser":"false",
"EmployeeNumber": "45555555"

}
}]

}

The following image shows how the REST call to update a contact would be performed in the Postman client:

Adding a User
Adding a user is very similar to adding a contact. However, as discussed in the import person document, users also 
get an account created in the SMA Suite Administration portal so that they can login to Service Management 
Automation X. To create a user that can login to Service Management Automation X, add all the required attributes 
but do not include the IsMaasUser field.  If a record with the same unique identifier (UPN) exists, Service 
Management Automation X updates the record. If a contact exists then it is converted into a user.  If no record exists, 
a new user record is added.  

{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": "MyNewUser@microfocus.com",
"upnDataType":"Customer_UID", (only if custom Upn and not Email)
"Email":"MyNewUser@microfocus.com",
"FirstName":"My First Name",
"LastName":"My Last Name",
"Location":"London",
"OfficePhoneNumber":"867-5309",
"EmployeeNumber": "4815162342"

}
}]

}
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Updating a User
Similar to updating contacts, the UPN field is used to search for an existing user. If one is found that record is 
updated, otherwise a new record is added. Using the body shown below would update the phone number of a user in 
Service Management Automation X and also in the Service Management Automation Portal.
{

"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": MyNewUser@microfocus.com,
"upnDataType":"Customer_UID", (only if custom Upn)
"EmployeeNumber": "4456234"

}
}]

}

Adding Groups to Users
The Manage Person API provides a way to update the groups that users belong to. Adding an additional parameter to 
the JSON payload allows groups to be added, replaced or removed.  The group can be added when users are 
created or when they are updated. The syntax below would add a group to an existing user. The Manage Person API 
uses the group’s UPN when adding a person to it. If one of the groups is an organizational group then the users 
organization will be automatically set. 

{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": "MyNewUser@microfocus.com"

},
"groups":{"ADD":["Marketing","Accounting"]}

}]
}

Using the Postman client, adding groups to a user would look like:

Another option available is to replace all groups the user has with a new (or multiple) group:

mailto:MyNewUser@hpe.com
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It’s also possible to remove any group or groups from a user (any groups not included would remain a group of the 
user)

Adding roles to users
Similar to adding groups, roles can be added to users in the same manner using ADD, REPLACE or REMOVE. The 
JSON syntax is identical, with the exception of the “roles” attribute name. 

{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": "MyNewUser@microfocus.com"

},
"roles":{"ADD":["Self-Service Portal User"]}

}]
}

When adding a role(s), existing roles remaining in place:
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When replacing roles, any existing roles are removed and the new ones added:

When removing a role, existing ones remain:

Adding licenses to users
The Manage Persons API can also be used to set the license information for a specific user. 

{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"Upn": "MyNewUser@microfocus.com"

},
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"licenses":{
"ADD":[{

            "type": "Named Users",
            "capacity": "5"
          }]

      }
    }]
}

Updates to multiple persons
One advantage to the Manage Persons API is that you can run updates on multiple records at the same time. When 
updating a large number of persons, using a script is often the best method for generating the JSON payload. In the 
example below, multiple contacts are being added to the system.

{
"operation": "CREATE_OR_UPDATE",
"users": [{

"properties": {
"IsMaasUser":"false",
"FirstName": "Steve",
"Upn": "MyNewUser@microfocus.com",
"OfficePhoneNumber": "5557788",
"LastName": "Smith",
"Location": "London",
"Email": "MyNewUser@microfocus.com"

}
}, {

"properties": {
"IsMaasUser":"false",
"FirstName": "Jason",
"Upn": "MyNewUser4@microfocus.com",
"OfficePhoneNumber": "5557781234",
"LastName": "Smith",
"Location": "London",
"Email": "MyNewUser4@microfocus.com"

}
}]

}

In Postman (note that the entire Body is not shown in the image) :
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Adding Attachments with the Case 
Exchange REST API using Postman

Introduction
Service Management Automation X provides REST APIs that can be used to execute a variety of commands. This 
chapter describes using the Add Attachment API that is part of the Case Exchange integration to add an attachment 
to a record.

This process is comprised of two separate actions that must be performed. The first is to add the attachment into the 
Service Management Automation X system. The second is to take the result of the first step and use that information 
to update the actual record with the attachment information, which adds the attachment to that record.

Before reading this chapter you should review the following:

• Configuring and Using the Postman REST Client
• Importing Users into Service Management Automation X

This chapter will cover:

• The Case Exchange Attachments API URL

• Setting the Request Headers

• Creating the Request Body

• Reviewing the Results

• Replacing the attachments of an Incident

• Adding an attachment to an Incident

• Adding a file as an attachment

• Creating the REST body using JAVA

Step #1 — Adding the Attachment to Service Management Automation X
The Case Exchange API URL uses the format https://<MasterNode>/rest/<tenantId>/ces/attachment. To access the 
API using the PostmanREST client, set the action to “POST” and enter the URL, then add the relevant information to 
the the body of the request.

Setting the Request Headers

The ‘Headers’ section must contain two specific headers. The ‘Content-Type’ will be set to ‘multipart/form-
data;boundary=YYYY’. The boundary in this example is set to “YYYY”, but any unique boundary may be used. Any 

https://en.wikipedia.org/wiki/Representational_state_transfer
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change to this boundary must be reflected in the body of the request (see section below).

The ‘User-Agent’ will be set to ‘Apache-HttpClient/4.4.1’. This allows Postman to pass the authorization to Service 
Management Automation X based on a logged in UI session. There must be a logged in SMA-X session (to the same 
tenant as the REST request is targeted) for the Postman request to work successfully.

Creating the Request Body

To create the body of the request, select the ‘Body’ tab and choose the ’raw’ option within the Postman interface. The 
Body of the Request must contain:

• The filename of the attachment

• The type of the attachment

• The attachment contents

The body is enclosed by the boundary specified in the Content-Type of the request, with two dashes before the first 
instance of the boundary, and two dashes before and after the second instance. If a different boundary token was 
used in the previous step, the ‘YYYY’ boundary must be replaced with that token in the example below.

The filename is specified within the ‘Content-Disposition’ line.  The line should read: Content-Disposition:form-
data; name="files[]"; filename="test.txt", where “test.txt” is replaced with whatever the attachment filename should 
be inside of Service Management Automation X.

The type of the attachment is specified as the ‘Content-Type’ tag. This value should contain the media type and 
subtype that matches the attachment’s MIME type. You can find a list of these MIME types here.

Finally, the contents of the attachment are listed. In the example below, the content is a simple string. This will result 
in a text file created in Service Management Automation X containing this string, with a filename of “test.txt”.

http://www.sitepoint.com/web-foundations/mime-types-complete-list/
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Once all of the information is entered into the request, press the “Send” button to send it to Service Management 
Automation X.

Reviewing the Results

After a successful request, the response contains the information that is needed to connect the attachment with a 
specific record inside of Service Management Automation X.

Adding a file as an attachment
In order to add a binary file as an attachment, there are a few changes to the procedures listed in Step #1 above. 
First, the ‘Content-Type’ should not be specified in the headers of the request.
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For the body of the request, select the ‘form-data’ option. Create an entry with a key of ‘files[]’, then select ‘File’ from 
the dropdown to the right of the value field. Now you may use the ‘Choose Files’ button to select the file that you wish 
to add as an attachment. 

Once you have selected the file you may send the request. Postman automatically handles the settings for the 
‘Content-Disposition’ and ‘Content-Type’ keys that were used in the earlier example. 

Step #2 — Adding the Attachment to an Incident
After the attachment has been successfully added, it must be attached to the proper Incident.  To perform this 
operation, the IncidentAttachments entry must be updated with information from the attachment response. This 
property contains a special ‘complexTypeProperties’ array in which the specific attachment properties are added. The 
properties that make up one entry in the complexTypeProperties include:

• properties - this is the top level attribute that contains all other attributes
⁃ id - the guid returned in the attachment response
⁃ file_name - the name returned in the attachment response
⁃ file_extension - the extension from the name property above (.txt for example)
⁃ size - the contentLength from the attachment response
⁃ mime_type - the contentType from the attachment response



Configuration Guide

136

⁃ Creator - the user that added the attachment, this should be the current login id/email

The Incident is then updated using the standard REST request (this can be the EMS REST API or the Case 
Exchange API). In our example above, the request body for updating the incident with id ‘27496’ would look like:

{  
   "entities":[  
      {  
         "entity_type":"Incident",
         "properties":{  
            "Id":"27496",       
            "IncidentAttachments":"{
                 \"complexTypeProperties\":[
                      {
                        \"properties\":{ 
                            \"id\":\"eac57a20-76e5-4318-842e-e46d3b6269c5\",
                            \"file_name\":\"test.txt\",
                            \"file_extension\":\"txt\",
                            \"size\":\"36\",
                            \"mime_type\":\"text/plain\",
                            \"Creator\":\"peter.budic@microfocus.com\"
                                       }
                      }
                  ]
             }"
         }
      }
   ]
}

 
Once the request updates the Incident, the attachment will be linked to the Incident. However, this will replace any 
other attachments that had been previously linked.

Adding attachments to an Incident

In order to add an attachment to an Incident rather than overwrite any existing attachments, an extra REST Request 
is required to get the existing IncidentAttachments attribute. This can be done with the standard GET REST Request.

When creating the Request Body to update the Incident with the new attachment, the existing 
‘complexTypeProperties’ array should be updated with a new array entry that contains the properties of the new 
attachment (as seen in the above example).

Creating the REST body using JAVA
The same concepts used with Postman may be used to create requests using a script or application. The same multi-
part/form data approach may be used. The file content must be extracted and placed into the body fo the request. 
The below code shows one example of how the body may be constructed from a Java File object. The File object is 
referenced as “fi” in the code example. Note that the Content-Type must also be specified, and the code below only 
supports files of type .jpg, .pdf, or .txt, but could be extended to support other types.

Important note: the following code is presented as an example of one way to create the request body. It should not 
be interpreted as the best or only way to perform this function, and is not officially supported in any way by Micro 
Focus.
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// Attachment file
File fi = new File(…);

// Get file extension
String extension = "";
int i = fi.toString().lastIndexOf('.');
if (i > 0) {
    extension = fi.toString().substring(i+1);
}
String contentType = "text/plain";
if ( extension.equals("jpg"))
    contentType = "image/jpeg";
if ( extension.equals("pdf"))
    contentType = "application/pdf";
if ( extension.equals("png"))
    contentType = "image/png";

// Generate prefix and suffix
String prefix = "--YYYY\n" +
        "Content-Disposition: form-data; name=\"files[]\"; filename=\""+ 
fi.getName()
        +"\"\n" +
        "Content-Type: "+ contentType + "\n" +
        "\n";

String suffix = "\n" + "--YYYY--\n";

// Calculate total payload length
long payloadLength = prefix.length() + fi.length() + suffix.length();

// Setup connection
HttpsURLConnection con = …
con.setRequestMethod("POST");
// Other headers
…

// Set HTTP connection output stream for POST body as non-cached fixed length
// The full content of the body is not stored in memory
con.setDoOutput(true);
con.setFixedLengthStreamingMode(payloadLength);
OutputStream os = con.getOutputStream();
DataOutputStream ds = new DataOutputStream(os);

// Write prefix to stream (as ASCII)
ds.writeBytes(prefix);

// Write file content to stream (as binary 8-bit octets)
InputStream is = new FileInputStream(fi);
byte[] buffer = new byte[1024];
int bytesRead;
while ((bytesRead = is.read(buffer)) != -1 ) {
    ds.write(buffer, 0 , bytesRead);
}

// Write suffix to stream (as ASCII)
ds.writeBytes(suffix);

ds.close();

// Handle HTTP response
…
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Importing Certificates into the OPB

Introduction
When creating an integration to Service Management Automation X with a remote system that has an SSL address, it 
is possible that the certificate of the remote server must be imported into the trusted keystore file of the On Premise 
Bridge (OPB). The cacerts file stores public certificates of root Certificate Authority (CA). If there is a problem with the 
connection between the OPB and the remote system, check the controller.log file of the OPB for the error defined 
below. If the error exists, then you may be required to follow the procedure described in this document.

javax.net.ssl.SSLHandshakeException: sun.security.validator.ValidatorException: PKIX path building failed: 
sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested target

This chapter will include:

• Finding the location of the Service Management Automation X OPB controller log

• Finding the location of the Service Management Automation X OPB trusted keystore

• Obtaining the certificate of the remote server

• Adding the certificate to the trusted keystore 

• How to identify if the certificate is present

Finding the location of the Service Management Automation X OPB controller log

The default location of the controller.log file is in the C:\Program Files\HP\On-Premise Bridge 
Agent\product\log\controller directory. Once the log file is located, search the log file for the HandshakeException 
error. If the error appears, the Fully Qualified Domain Name (FQDN) will be logged, which will allow you to verify that 
the endpoint in question was indeed the one that is giving the error.

Finding the location of the Service Management Automation X OPB trusted keystore

The default OPB trusted keystore file is named cacerts and is located in the C:\Program Files\HP\On-Premise Bridge 
Agent\product\util\3rd-party\jre\lib\security directory. The OPB has its own file and should not be confused with any 
other Java installation on the machine. 

  

http://docs.oracle.com/javase/6/docs/technotes/tools/solaris/keytool.html%22%20%5Cl%20%22KeyStore
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Obtaining the certificate of the remote server

In most cases there is a company created certificate available and the server administrator will be able to send it to 
you. In cases where this is not available, it is also possible to use a browser (FireFox for example) to export the 
certificate so that it can be imported into the OPB’s trusted keystore.  

Adding the certificate to the trusted keystore 

The java keytool utility is used to import certificates into the trusted keystore. To run the utility, open a command 
windows and navigate to C:\Program Files\HP\On-Premise Bridge Agent\product\util\3rd-party\jre\bin directory. The 
format of the necessary command is as follows: 

keytool -import -keystore ..\lib\security\cacerts -alias "new Alias" –file myCert.crt . 

In this example the myCert.crt file is the certificate of the remote server, cacerts is the trusted keystore, and the alias 
is a label set for the certificate. When prompted for a password, “changeit” is the default.

How to identify if the certificate is present

Java uses a tool named keytool to list or import any certificates in the trusted keystore file. Using this tool allows you 
to list all of the certificates that were imported into the keystore. Open a command window and navigate to the C:
\Program Files\HP\On-Premise Bridge Agent\product\util\3rd-party\jre\bin directory. Run the keytool while pointing to 
the cacerts file. Syntax for the command is: keytool –list –v –keystore ..\lib\security\cacerts > c:\contents.txt.

The default password for the keystore is “changeit”. Once executed, a file named c:\contents.txt will list the entire 
content of the keystore. It is possible to search through this file in notepad or a similar text editor in order to confirm 
that the certificate for the remote server to confirm was loaded correctly. 

http://docs.oracle.com/javase/6/docs/technotes/tools/solaris/keytool.html
http://docs.oracle.com/javase/6/docs/technotes/tools/solaris/keytool.html
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Configuring Email Integration with a 
Gmail Account

Introduction
Service Management Automation X provides an email integration that may be used to request appropriate knowledge 
articles, create requests, add comments, and accept a solutions to existing requests. The email integration uses the 
on premise bridge to connect to an external inbox in order to process incoming emails. This document describes how 
to configure Gmail as the external inbox to use with the Service Management Automation X email integration. 

This chapter will include:

• Configuring the Gmail account

• Determining where to install the on premise bridge (OPB)

• Downloading the OPB configuration file

• Downloading the OPB installation binary

• Installing the OPB

• Adding the Gmail addresses email integration credentials to the OPB

• Creating and configuring the email integration endpoint on Service Management Automation X

• Troubleshooting issues

Configuring the Gmail account
The Service Management Automation X email integration uses IMAP to communicate with the remote email server. 
By default Gmail disables the ability to connect using IMAP, so you must enable IMAP in the Gmail account settings. 
To enable IMAP, access the Gmail settings and select the Forwarding and POP/IMAP menu. Select the Enable IMAP 
Button and then save the settings.

http://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content//Search.htm#search-on%20premise%20bridge
https://en.wikipedia.org/wiki/Internet_Message_Access_Protocol
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The IMAP protocol allows Service Management Automation X to move emails from the inbox to other folders once 
they have been processed. By default emails successfully processed are moved into a folder named ‘Processed’, 
while emails that have an issue with being processed are moved into a folder named ‘Errors.’ These folders must be 
created in Gmail and will appear in the list of folders. Once the folders are created and IMAP is enabled, the 
configuration of the Gmail account is complete.

Determining where to install the OPB
You must install the On Premise Bridge on a machine that has access to both the Gmail server and the Service 
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Management Automation X tenant at all times. Micro Focus recommends against installing the agent on laptops or 
machines that are not actively maintained for consistent uptime. The firewall on the machine must allow the agent to 
connect to ports 993 and 465 (the default Gmail IMAP and SMTP ports). If there are connection issues, open a 
command window and try to telnet into the ports. If this is not possible the integration will not be possible from this 
machine. The primary cause of the ports not appearing open is a firewall between the OPB machine and the Internet.

Downloading the OPB configuration file
There are two steps to installing the On Premise Bridge. First, download the OPB connection file. Second, download 
the installation binary (covered in the next section). To download the OPB connection file, open the Service 
Management Automation X UI and then navigate to Admin-> integration->Agents. Click on the ‘Add agent’ button to 
launch the new agent form. Enter a name for the agent and then click on the ‘Download Connection File’ button. 
Once clicked, a file with the information on how to connect to this specific tenant will be downloaded. The connection 
file is unique per tenant and has information including the agent name, tenant number and farm location. After 
downloading the file, it will need copying to the machine where the OPB will be installed. The configuration file is 
named server-connection.conf.  
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Downloading the OPB installation binary
The On Premise Bridge agent installation is available for download from the Service Management Automation X UI 
on the Admin -> Integration Management -> Agents page. Then click on the ‘Download agent’ button. The agent is 
~200mb in size and may require several minutes to download. The file is named opb-installation.exe

Installing the OPB
Copy the installation binary downloaded in the previous to the machine that it will be installed on and double click to 
launch.
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The user name and password in the ‘Setup authentication’ form is the account used to login to Service Management 
Automation X. The user name combined with the OPB configuration file tells the agent how to connect to the Service 
Management Automation X tenant.
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Click the install button to complete the installation.
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To complete the configuration of the agent, copy the ‘server-connection.conf’ file downloaded in the previous step to 
the conf folder of the OPB (by default located in the C:\Program Files\HP\On-Premise Bridge Agent\product\conf 
directory). Once copied, start the On-Premise Bridge service (this service is not started by default after the 
installation).



Configuration Guide

148

Once started, confirm that the agent has been configured correctly by bringing up the Service Management 
Automation X Integration page and clicking on the agent just created. Confirm that the status is ‘Success’. If it did not 
connect successfully, try restarting the agent. If restarting does not correct the issue, consult the controller log located 
in the C:\Program Files\HP\On-Premise Bridge Agent\product\log\controller directory for more information on 
connection issues.



Configuration Guide

149

Adding the email integration credentials to the OPB
After installing the agent you must add the email integration credentials to the OPB so that the agent can connect to 
the Gmail account. This is done using the ‘Endpoint credentials manager’ of the OPB, available in the start menu.
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When the credentials manager opens, click the ‘New’ button and then select the OPB email integration domain option 
from the list and click OK.
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Add a name which will appear in Service Management Automation X UI when you add the email integration endpoint. 
Then add the email address and password used to login to the Gmail account (Gmail configured in an earlier step).

Creating and configuring the email integration endpoint
Once the credentials have been added to the OPB, you need to add the email integration endpoint through the 
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Service Management Automation X UI. Navigate to the Admin -> Integration -> Endpoints page. Click ‘Add’ and 
select ‘email integration’ as the endpoint type and provide a name. The ‘Running on agent’ dropdown should contain 
the ‘email integration agent’ added earlier. Select it and then click ‘Add’.

Once added, click the ‘Configure’ button to add the connection details for the Gmail server. The Gmail IMAP server 
address is imap.gmail.com and the smtp server is smtp.gmail.com. The recommended protocol to use is IMAPS. 
The Credentials dropdown should show the Gmail credentials added to the OPB in an earlier step. 

Any proxy configuration is performed in the ‘Advanced’ connection configuration section of the form. There is no 
specific customization needed when using Gmail, as it uses the default ports. If you are using a different email server 
with non-default ports, you may need to modify the values on this form. 

Only authorized email addresses can create requests in Service Management Automation X using the email 
integration. If the domain of the sending email address is not in the authorized domain list, the email will not be 
accepted. The same is true for email accounts that do not belong to a valid user in Service Management Automation 
X. Even when the domain is added to the authorized domain, the email address must be associated to a valid user 
for a request to be created. You must add any domains that will be sending emails to the authorized domains.
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The actions Service Management Automation X will take when emails arrive in the Gmail inbox is defined in the 
configuration section. If the ‘New email action’ is set to ‘Create Request’, then a new request will be created. 

The inbox polling time is by default one minute, but can be increased to any desired frequency. By default the two 
Gmail folders created earlier are assumed to be named ‘Processed’ and ‘Errors’. If different folder names are desired, 
they may be defined here. 

It is possible to set a default offering on this form for all requests submitted through the email integration. If this 
dropdown is left blank then no offering will be applied. However the default can be assigned by selecting a value from 
the list. Once saved, the email integration should be functioning.

Troubleshooting
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The OPB logs are located in the C:\Program Files\HP\On-Premise Bridge Agent\product\log directory. This directory 
should contain a controller folder and an email-integration-domain folder. To make sure that the agent is running, look 
in the controller folder for the controller.log file. Look through the log for any errors -- most likely they will be related 
to a login and password not working.

If the agent is running then look in the email integration folder for the email-integration-domain.log.x.x file. Look for 
the most recent file for any errors. There may be errors indicating that the Gmail account login or password is 
incorrect. There may also be errors indicating that the inbox cannot be found, which may indicate that the firewall is 
blocking a port. 

If the integration still doesn’t work contact the Micro Focus Service Management Automation X Support team and 
create a ticket. Be sure that all of the OPB log and configuration files are included.
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Business Intelligence Synchronization

Introduction
The Business Intelligence (BI Sync) Integration module enables you to define the fields and relationships that are 
available for a specific record type when exporting data for use with an external business intelligence system. BI Sync 
can be used to export information not currently available in the SMA-X reporting framework 

This chapter will include:

• Enabling BI Sync on your Service Management Automation X tenant

• Adding the required record types and fields necessary for generating the desired reports

• Executing the REST call that generates the data

• Downloading the data

Enabling BI Sync on your Service Management Automation X Tenant

BI Sync is a resource intensive feature, and is disabled by default when a new Service Management Automation X 
tenant is created. To determine if BI Sync is enabled on your tenant, navigate to Administration->Integrations and 
then select “BI Integration”. The system will display a message on the screen if the feature is disabled. You must 
create a ticket with the Service Management Automation X support team in order to enable the BI Sync feature.

Adding the required record types and fields necessary for generating the desired reports

BI Sync allows users to export all desired transactional data available in Service Management Automation X. The first 
step is configuring the entity types that you wish to export. From the BI Sync menu, select an entity type from the 
Record type list. Then select all fields from that entity that you wish to export. It is important to note that when specific 
fields are dependent on other entity type an indicator is seen next to the field name. You will need to export each of 
these entity types as well. For example, if you are exporting the requested by person of an Incident, both the incident 
and person entities must be exported.

Executing the REST call that generates the data

After selecting the entity types and fields that are required, you must execute a REST call to schedule a job which 
prepares the data. In systems with a large amount of data, it may take several hours until the data is ready for 
download. 

To start the job execute the following REST call: https://<MasterNode>/rest/<tenantId>/bi/initial . This will perform a 
FULL synchronization of the data. If you have already downloaded data it is possible to generate a second download 
that only includes the differences in the data since the last initial synchronization was run. When the REST call is run 
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it will provide a SyncId. The Sync Id is required to be able to tell when the job is done and where the resulting files are 
stored.

Downloading the Data

Run the REST call https://<FarmName>/rest/<tenantId>/bi/status/<syncId> in order to see if the Job has completed.

The result of the REST call will include "Status": "COMPLETE", if the job has completed. When complete there will be 
a “files” section that lists all of the Ids of the files that were created during the export. There may be multiple files for a 
specific entity type depending on the number of records exported. The files are compressed in Zip format. You will 
need to download all of these files. In some situations creating an automated script may be the most efficient means 
of downloading all files. 

Files are named in the format "FileId": "4743431f-6c4b-4f24-87b8-bfe15721da97". To download the file from the 
browser, ensure you are currently logged into the Service Management Automation X system, then type the following 
URL into the browser: https:/<FarmName>/rest/<tenantId>/frs/file-list/<FileID>

Detailed Use Case
A company named ABC Reporting wants to use a 3rd party tool to run reports on Service Management Automation X 
transactional data. The customer wishes to use the Tableau Desktop application to generate the following reports:

• An Incident report that includes the related Requests that exist for each Incident

• A groups report with the names of each member of the group

Report 1

Data required selecting in BI Sync for the Incident report including the number of related requests:

Incident-> Id, DisplayLabel, Incident caused by Request.

Request->Id, DisplayLabel

After running BI Sync download the files (3 files in total), launch Tableau Desktop. 

From the connect menu, select the Text file option. Navigate and select the Incident_0.csv file. After it loads the other 
files will be loaded at the same time. The table editor view will open, drag the Incident_0.csv, Request_0.csv and 
IncidentCausedByRequest_0.csv files into the work area (note: depending on the amount of data there may be 
multiple files for a specific entity type).
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v

Click on the join between the Incident and IncidentCausedByRequest_0.csv, in the Data Source select the incident 
ID, and select the FirstEntity Incident from the IncidentCausedByRequest_0.csv.

Click on the join between the IncidentCausedByRequest_0.csv and Request_0.csv. In the Data Source select the 
secondEntity Request, and in the Request_0.csv select the Id (Request_0.csv).
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In the worksheet view, drag the Display Label field from Incident, the Id(Request_0.csv) and the DisplayLabel for the 
request. The report will now list the Title of the Incidents in Column 1 and the titles of the related requests in Column 
3.

Report 2

Data required selecting in BI sync for the Group Report that includes the people in each:

Person-> Id, Name, Group Members (See screenshot below)
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Groups->Id, Name

Launch Tableau and from the connect menu select the Text file option. Navigate and select the PersonGroup_0.csv 
file, when it loads the other files in the same directory will be loaded. The table editor view will open, drag the 
PersonGroup_0.csv, Person_0.csv and PersonToGroup_0.csv files into the work area.
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Click on the join between the PersonGroup_0.csv and PersonToGroup_0.csv, in the Data Source select the Id, and 
select the SecondEntity PersonGroup in PersonToGroup_0.csv

Click on the join between the PersonToGroup_0.csv and Person_0.csv, in the Data Source select the FirstEntity 
Person, and select the Id(Person 0,csv) under Person_0.csv.
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Click on Sheet 1 to open the worksheet. Drag in the PersonGroup_0.csv -> Name field into the row and then the 
Person_0.csv -> Name field. The report will now lists the Groups with the people that are members.
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Performance Considerations

Introduction

The architecture of the Service Management Automation X application and supporting hardware has been designed 
with performance as one of the primary considerations. However, as the browser is heavily relied upon when 
performing many operations, performance issues may occur that are caused by the client system rather than the 
backend application. 

When experiencing possible performance issues there are several areas to investigate, including:

• Browser type

• Number of open browser tabs

• Available system resources

• Power settings

• Live Chat settings

• Network latency

Browser type
Service Management Automation X works with a number of modern browsers, including all of the major ones 
(Chrome, Firefox, and Internet Explorer). Consult the supported browsers matrix to see a full listing of the supported 
browser and versions. The Chrome and Firefox browsers both support a number of tools and plugins that may assist 
in any needed issue determination, and in many cases these browsers perform better than Internet Explorer when 
working with Service Management Automation X. If performance issues are occurring, try performing the same 
actions using different browsers to see if there is any impact on performance.

Number of open browser tabs
Processes and connections are running constantly when users are connected to Service Management Automation X. 
Each additional tab in the browser is consuming additional system resources. The more open tabs, the more 
resources being consumed. If possible try to avoid having more than four or five tabs open within the browser. If 
performance issues occur, close any unused tabs and retry the same action.

http://docs.software.hpe.com/ITSMA/2017.11/NG/SM_X/Content/1000_GettingStarted/gsSupportedBrowsers.htm
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Available system resources
While running Service Management Automation X the browser will consume system resources on the computer. As 
more tabs are opened and more operations are performed, system memory and CPU usage will increase. On 
machines with limited memory (less than 4GB) or that are running 32 bit operation systems, this may result in 
reduced performance depending on the amount of free memory available for the browser to consume. 

On systems where system resources are heavily used even before Service Management Automation X is started it is 
possible that slow performance may occur. To see if this may be an issue, open the Task manager to see the amount 
of available memory and CPU. The higher the “available” memory, the less likely this scenario is occurring. If possible 
try closing other applications to increase free memory, which may result in improved performance.

Power settings
When running the Windows operating system there are a number of options available that will limit power 
consumption. If the Power Saver option is enabled it will increase the energy efficiency of the CPU so that it uses less 
power. However, this operates the CPU at slower speeds which is known to cause performance issues when using 
Service Management Automation X. Using the power saver mode is not recommended. Using the balanced option 
should not cause any performance issues with Service Management Automation X.
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Network latency

The	network	connec,on	speed	to	the	Service	Management	Automa,on	X	server	plays	a	pivotal	role	in	the	

performance	of	the	product.	There	are	a	few	ways	to	determine	if	performance	is	being	impacted	because	of	a	

local	issue	or	network	performance.	

One	way	to	test	the	quality	of	the	network	connec,on	is	to	use	the	Chrome	browser	network	traffic	tools	to	see	

how	long	queries	are	taking	to	run.	Launch	the	Chrome	browser	and	then	press	F12	to	open	the	development	

tools.	Click	on	the	network	tab	and	then	perform	the	opera,on	that	is	taking	a	long	,me	to	complete.	

	

When	the	opera,on	is	occurring	observe	the	,me	required	for	the	informa,on	to	be	returned	from	Service	

Management	Automa,on	X,	if	these	,mes	are	consistently	high	then	the	performance	issue	may	be	bandwidth	

related.	However,	there	could	be	mul,ple	causes	for	the	performance	degrada,on,	including	backend	performance	

or	browser	issues.
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Creating a ticket
If after checking all of the previous areas performance issues continue, open a ticket with Micro Focus Support and 
include the following information:

Browser information including the version and build number.

Screen capture of the Performance tab of the task manager showing the memory and CPU usage.

HAR Files from the Chrome browser when the performance issue is occurring and a description of 
what you are doing. Try to only include the data from at or around the time you are repeating the action that 
is having performance issues.

Steps to capture the .har files can be seen here:

https://www.youtube.com/watch?v=RSV0VTNz7d8

https://www.youtube.com/watch?v=RSV0VTNz7d8
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Dev2Prod Concepts and 
Troubleshooting

Introduction
The process that moves configuration changes from a development tenant to a production tenant is known as 
Dev2prod. A dev2prod package is exported on a development tenant and then imported on a production tenant. 
Dev2Prod does not move data, it only moves configuration. The following document outlines some of the concepts 
and the common errors that may occur in this process and what to do if these errors occur. 

What moves in the dev2prod process?

The online help describes all the components that move, conceptually it’s important to understand that dev2prod only 
moves configuration data.  This means that the service catalog does not move and neither do things related to it such 
as categories, offerings, services, service definition, entitlement rules, groups, change definitions, templates and 
people. Things like incident, requests or changes are also considered data so they don’t move.

Service Management Automation X has 2 types of lists, Volatile and Non-Volatile. Volatile are lists that are created 
within the offering itself. There is no limit to the number of these types of lists however they are not moved by 
dev2prod. These lists are part of the service catalog and would need to be created on the production tenant. Non-
Volatile lists are moved, they are created directly in the list management menu in Service Management Automation X. 
Lists that are going to be moved can be identified in the list management view by looking to see if there is an icon 
next to the list name. The icon will indicate that the list is a ‘Volatile’ list, this means the list was created in an offering 
and since offerings do not move then the list will not move either. If there is no icon next to the list name then it will be 
moved.
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Tenant types

Tenants have 3 different settings:

1. Trial
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2. Development

3. Production

These settings are managed by the Service Management Automation X support team and determine what the tenant 
is used for. Trial tenants are meant to be used for a trial experience they are not intended to be used in any other 
mode than the initial introduction to Service Management Automation X. Development tenants are used to create the 
configuration changes that are intended to be moved into Production tenants. Development tenants are not locked 
and any configuration changes can be made to them including rules, email templates fields etc. Production tenants 
are used by live customers, these tenants have their configurations locked so that no changes can be made that may 
impact end users. Fields cannot be added, rules cannot be changed and lists edited. The only way to change 
configuration items on a production tenant are to move them there using the Dev2prod process. 

Error: Development tenant was not configured

The Production tenant has a parameter that is set by the Service Management Automation X support team that 
identifies the development tenant. This value is used by the system to make sure that a dev2prod package is not 
imported onto an incorrect tenant. In some cases when new tenants are created it’s possible that the development 
tenant Id has not been set on the Production tenant. If this occurs, a ticket will need to be created with the Service 
Management Automation X support team to correct the issue. 

Export, Simulate Import and Import

On the development tenant the dev2prod package is exported by clicking on the export button. On the production 
tenant Service Management Automation X has an option to simulate the import of a package. The simulation will 
allow you to determine if the package is going to import successfully or if there are going to be issues. Best practice is 
to always simulate the import before you run the actual import. 

Interpreting workflow error messages

Error messages in Service Management Automation X are available in the import configuration menu after the import 
process has completed. Thoroughly reading through the error messages is very important. In the example below, only 
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the errors labelled Customization1(1) and Customization1(2) are the actual error messages. Any error messages that 
include the line “Element is not included as a valid metadata element, since it is defined in a context which contains 
violations” is only providing information on the element and not the cause of the import failure (eg. Customization(3) 
below). After fixing the actual errors (Customization1(1) and Customization1(2)) another export of the package needs 
to be done and the import can be tried once again. It’s also important to understand that when part of the import fails 
the whole import fails. Once the obvious errors are corrected a new package should be export and the import should 
be run again. The simulate import is a useful tool for this as the simulation can be run at any time without affecting 
users currently logged into the system.

Set field rules on Entity Links

Set field rules that select values from an entity link field will most likely need to be corrected on the production tenant 
after the dev2prod process. When creating a rule with an entity link, Service Management Automation X uses the Id 
of the value selected in the dropdown list in the rule.  The Id of the value selected will most likely be different or not 
exist at all on the production tenant so the rule may either be invalid or set the field to an undesired value.

To identify rules that have this issue review the type in the Records-> Fields listing for the entity.

If you have rules that fit this description then you will need to request your tenant be unlocked after Dev2Prod and 
then manually make the appropriate changes to update the rules to reference the correct records from your 
production tenant. If this issue exists the rule may appear with an incorrect or blank value. If possible use a DSL 
expression to add the values for these types of rules.
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Error: Resource validation failed: The field “<FieldName>” is not defined in the entity’s metadata

This error message occurs because a field that is defined on one of the forms was deleted from the list of available 
fields but not from the form. The error message will indicate which form the field causing the issue is on. In Records-
>Forms remove the field from the form and then re-export the package and try the Dev2Prod again.

Error: Update of existing element descriptor’s attribute is not available through customization

For fields of type Boolean, Date, Date_Time, Double, Integer, Large_Text, Small_Text, Medium_Text, Rich_Text and 
Percentage, this error occurs when the ‘Enforce uniqueness’ or ‘Required’ field attributes differ between the Dev and 
Prod tenant.

In order to identify the problem with the field compare the field attributes on the development and production tenants. 
It’s possible to change the ‘Enable Sort’, ‘Enable search’, ‘Read Only’ and ‘Hidden’ attributes and move the changes 
into Production however it is not possible to change the ‘Enforce Uniqueness’ or ‘Required’ check boxes. If the error 
described above occurs then these values must be aligned to solve the issue, if the ‘required’ box is checked it 
means that one of the fields was incorrectly added directly to the Prod tenant or the field was deleted and then re-
added on the development tenant with a different value than the production tenant. Either way correcting it will require 
deleting the field entirely and re-creating with attributes that match the production field. 
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Error:  Reference Name is invalid. Update of existing element descriptor’s attribute is not available 
through customization

For Entity link fields, if a field with the same name exists or the field was deleted and the added back on the 
development tenant the error below with the ‘Reference name is invalid’ occurs (Customization(1) and 
Customization(2) below). Currently the only way to correct this issue is open a ticket with the SMA-X support team.
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Error: Metadata element <fieldname>.<value>.Order is invalid

In older tenants, it’s possible that a value in a list on the production tenant could have been added without using the 
dev2prod process. Correcting this requires creating a ticket with the SMA-X support team. 

Error: Property <name> not found

This error occurs if a field is referenced in a rule but the field was deleted from the tenant before the package export. 
To correct, either fix the rule or add the field back on the development tenant and then re-export the package.
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Error: Survey with name <SurveyName> does not exist

Rules can reference surveys by name, however the surveys are not transferred in dev2prod. To correct this a survey 
needs to be added to the Production tenant with the name that is referenced in the rule. No need to re-export the 
package.

Error: Routing Definition with name <Name> does not exist

Routing definitions are referenced by name in the rendering rules of the workflow. Routing definition are not 
transferred in the dev2prod process so on the production tenant the routing definition with the name used in the rule 
needs to be added. No need to re-export the package from dev.

Error: Update of an existing element – because of a duplicate list
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It’s possible to end up with a situation that a list is created in list management and moved in the dev2prod process 
that already exists on the Production tenant because a list with the same name was added through an offering.  To 
determine this use the list management tool, compare the list name on the Development tenant and the Production 
tenant. If the Production tenant has the Volatile icon next to it you will need to open a ticket with SMA-X Support to 
get the problem fixed. To do this you will need provide information on which list is actually correct.

Broken image link in the email header or footer

The dev2prod process does not currently support moving images in the email header and footers from the 
development tenant to the production tenant. If the image in the header or footer is updated on the development 
tenant, a ticket will need to be created with SMA-X support to get the tenant temporarily unlocked so that the image 
can be updated on the production tenant.
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On Premise Bridge Troubleshooting

Introduction
The Service Management Automation X On premise bridge (OPB) communicates with remote systems used in 
integrations. The OPB is installed locally in a customer’s environment and must have an available connection to both 
the Service Management Automation X tenant and the machine used for the second part of the integration. This 
document outlines a number of common problems that may occur when installing and configuring the OPB. This 
document also assumes that the OPB installation has been performed and the configuration file has been copied to 
the appropriate directory.

This chapter will review steps related to:

• Current connection status

• OPB agent service status

• OPB log files

• OPB login credentials

• OPB configuration file

• Connection timeout error

• Proxy certificate
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Current OPB connection status
After completing the OPB installation and adding the agent to the tenant, there is a simple method to determine if it is 
functioning correctly. Navigate to the Administration -> Integration menu and click on ‘Agents’. Now find the ‘Agent 
last viewed’ field on the form. This field will indicate a last connected time or a value of ‘unknown.’ The agent regularly 
contacts the Service Management Automation X tenant so this value should be a recent value if the agent is 
functioning correctly. If the value is ‘unknown’ then there is a communication issue that requires more investigation.

Example of ‘Unknown’:

Connection successful example:
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OPB agent service status
In order for the OPB to communicate with the Service Management Automation X tenant the OPB service must be in 
the started state. On the OPB machine, open the windows services list and confirm that the ‘On-Premise Bridge’ 
service exists and is started. If the value in the status list is blank, right click the service and select “start”. If the value 
is ‘started’ then the service was started correctly.

Example of agent NOT running:

Example of agent running:

OPB error log messages
The default OPB installation directory is C:\Program Files\HP\On-Premise Bridge Agent. This directory will contain a 
folder named ‘log.’ In the log folder there is a ‘controller’ directory that contains the controller.log file where details 
about the running state of the OPB are stored. 

Errors will appear similar to the example below. The log shows an attempt to connect, followed by a ‘Doing login’ 
entry, and finally an exception with specific error messages. The error messages can be from a variety of causes 
outlined later in this document. Any errors are usually found in the last few lines of the log file. 

Error example: 

[2016-08-02 14:04:16,779] ERROR [login] (LoginInvoker.java:50) Login failed with 
exception: 
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OPB login credentials
Login/authorization issues are a common cause of Service Management Automation X OPB not correctly connecting 
to the tenant. When installing the OPB it is possible that incorrect login credentials may have been entered. The 
‘forbidden’ message usually indicates an incorrect username and/or password, but may also be caused by and 
expired password or the account being linked to SSO for authorization. The error message that appears when this 
happens (in the controller.log file) can be seen in the example below.

[2016-08-04 14:28:26,979] INFO [login] (LoginInvoker.java:59) Doing login to https://
msast002popb.domain.com:443/auth/authentication-endpoint/authenticate/login 

[2016-08-04 14:28:31,605] ERROR [login] (LoginInvoker.java:82) HTTP failure! URI: 
https://msast002popb.domain.com:443/auth/authentication-endpoint/authenticate/login; 
Status: HTTP/1.1 403 Forbidden 

[2016-08-04 14:28:31,607] INFO [login] (LoginGatewayImpl.java:195) Waiting 30 sec 
before next login

The first step in troubleshooting these issues is to login to the Service Management Automation X UI using the same 
credentials and determine if the login works correctly. If the account fails to login it is possible that the password is 
incorrect or more likely it may have expired. If the password has been corrected and you are able to login to the 
Service Management Automation X UI the next step is to correct the password stored in the OPB.

To reset the OPB login and password open a command line window and navigate to the C:\Program Files\HP\On-
Premise Bridge Agent\product\util\opb directory. Enter the command “agentAuthentication.bat setAuth -user 
maasuser@hp.com -pass thepass” and press enter. This command will reset the password. You will need to restart 
the OPB for the new password to take effect.

If the OPB still gives the same error message (with “HTTP failure! URI”) the next step is confirm that the 
authentication URL is validating the login. Open a browser and enter the following: https://<master node url>/auth/
authentication-endpoint/authenticate/login?login=MyLogin&password=MyPassword

Substitute the server name and the login and password for the credentials that are not working. If there is a login 
issue this will result in an error code 403 (see screenshot below). If this is the case confirm that the account is a non-
SSO account (not an account that exists in the customer active directory as part of an SSO integration). The account 
needs to be created and exist in the Suite Administration module.

If the account authenticates correctly it would return a result similar to the following screenshot. If the token is 
returned correctly, reset the password and restart the agent again. 
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OPB Configuration file
The final step in the installation process for the OPB is to copy the server-connection.conf file into the C:\Program 
Files\HP\On-Premise Bridge Agent\product\conf directory. The default login URL that the OPB uses to login to 
Service Management Automation X is stored in this file in the format <Farm Location>.saas.hp.com. If the server-
connection file has not been correctly been copied into the conf directory, an error message will appear indicating the 
OPB is trying to login to the local machine’s DNS name. The error will appear as below, in this case the name the 
OPB is installed on ‘mymachine’. If the error occurs, confirm that the server-connection file is present in the directory 
(procedure described below). 

Example Error message:

 [2016-08-02 14:04:16,235] INFO [login] (LoginGatewayImpl.java:175) Login gateway 
started up 

[2016-08-02 14:04:16,580] INFO [login] (LoginInvoker.java:59) Doing login to http://
mymachine.net:9090/auth/authentication-endpoint/authenticate/login 

[2016-08-02 14:04:16,779] ERROR [login] (LoginInvoker.java:50) Login failed with 
exception: 

When an agent is added to Service Management Automation X a unique configuration file is created. The 
configuration file cannot be used on any other tenant or even on the same tenant if the ‘Agent’ is deleted and then 
added again. The following example shows the ‘SMA-X Agent’ has been created and the file content can be seen as 
well.

The server-connection file will contain the following information:

If the tenant ID is incorrect an error similar to the following will appear:

ERROR [WrapperSimpleAppMain] (HttpClientRequestInvoker.java:107) HTTP failure! URI: 
https://msast002popb.domain.com:443/rest/844143557/remoting/descriptor?
agent=a2c82cf4506f6b3b925ef838&TENANTID=8414143557; Status: HTTP/1.1 401 Unauthorized

Confirm the tenant ID using the “about” box in the Service Management Automation X UI. If these values do not 
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match there is an installation issue or the wrong configuration file exists on the machine.

The agent ID can be confirmed by using the chrome developer tools. Click refresh while the agent is selected and 
then view the network information. The value between the %27 is the agent id that should match the value in the 
config file(agent.id). Mismatched agent ids will not display an error message in the log.
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Connection Timeout
Another possible issue preventing connection to the Service Management Automation X tenant is that a proxy, 
firewall, or dns issue is stopping the OPB from connecting to the tenant. In the OPB controller.log (described above) 
search for an error message similar to:

[2016-07-21 11:01:32,461] ERROR [login] (LoginInvoker.java:50) Login failed with 
exception: 

org.apache.http.conn.HttpHostConnectException: Connect to msrdg001popb.domain.com:443 
[msrdg001popb.domain.com/131.124.92.157] failed: Connection timed out: connect

This message can be the result of a network level issue. On the machine with the OPB installed, open a browser and 
connect to the URL of the Service Management Automation X Tenant. For example: https://
msast002pngx.domain.com/?TENANTID=844143551

If this URL redirects the browser to the HPE login page it is possible that there is a proxy or network issue that also 
needs to be configured on the OPB. In the browser (on the OPB machine) go to ‘settings’ and find the option that 
displays proxy information. The dialog should be similar to this example:

To add a proxy to the OPB go to the C:\Program Files\HP\On-Premise Bridge Agent\product\conf directory and edit 
the wrapper-maas.conf file. Add the address and port of the proxy as seen in the example below.
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The Service Management Automation X OPB connects to the server on port 443 (the default SSL port). In rare 
occasions it is possible that the port or URL are blocked by firewall settings. A simple way to test that the port is not 
blocked is to use the telnet program to connect to the port on the server. Telnet is available on all windows machines 
but may need to be enabled in the control panel. Once enabled open a command line and enter “Telnet 
<servername> 443 . The server name can be found in the server-connection file, in this example we will use 
msast002popb.comain.com

If the connection is successful the screen should blank but when a character is typed the cursor moves.

If no connection can be made an error will appear:
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DNS issues may also be the cause of the OPB not connecting. To test, try to ping the hostname of the url. Example 
for the Austin farm:

As long as the message following the ping does not indicate it cannot find the host DNS is probably not the issue.

Proxy Certificates
In some cases if a non-transparent proxy is used the OPB will not be able to connect to Service Management 
Automation X and will display an error message in the log that indicates it cannot find a valid certificate. An example 
of the error message is seen below. 

2016-07-29 09:16:33,015] ERROR [login] (LoginInvoker.java:50) Login failed
with exception:
javax.net.ssl.SSLHandshakeException:
sun.security.validator.ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to find
valid certification path to requested target
   at sun.security.ssl.Alerts.getSSLException

The customer’s IT department will need to be contacted to see if there is a certificate that needs to be imported into 
the trusted key store of the agent. 
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Frequently Asked Questions

Question: How does searching work in the Self Service Portal?

Answer: 

Service Management Automation X provides multiple features to help the end user find the information that they are 
looking for as quickly as possible. This includes the functionality of the Search Field, as well as displaying information 
related to search terms or displayed records.

Search Field

As soon as the Search Field is selected, Service Management Automation X displays the user’s most recent 
searches as well as any Offerings that they had requested recently.

Once the user beings typing into the Search Field, but before they execute the search, Service Management 
Automation X may return information in two ways.

First, the ‘Suggested search’ section will display similar search criteria made by other users. If the end user clicks on 
one of the suggested searches, the system will execute a search using the selected search term(s).
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Second, the ‘Suggested results’ section will show possibly related records. These records are searched based on 
their title only, not their complete contents. Service Management Automation X will search the following record types 
(some types may be ignored based on the Self Service Portal feature settings):

• Knowledge Articles

• User Questions

• Ideas

• Offerings (both Service and Support)

• Public Requests

If the user clicks on one of the selected records, the portal will display the full record.

If the system does not find any suggested searches or results that match what is typed in the search field, that 
section will not be displayed. If neither section has any matching information, the only option will be to execute a 
search with the contents of the search field.

Once the search is executed Service Management Automation X will display a list of possible matches from the same 
record types specified above. However, for the full search SMA-X will search additional fields in addition to the title. 
The search is performed against the following fields:

• Title

• Content

• Description

• Tags
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In addition to the returned records, the portal will also show possibly related searches on the right hand pane.

The end user may filter the results to only show specific record types.

Related Records

When viewing specific types of records resulting from a search, Service Management Automation X will also display 
related information on the right hand sidebar. Up to three related records will be displayed.
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The related records are displayed based on the type of record that was originally selected:

Offerings

Displays related offerings 

Articles

Displays related articles
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Question: if I have multiple tenants (such as development and production), can I 
use the Manage Persons API to add users to specific tenants?

Answer: 

When you add a user you specify the tenant Id as part of the request.  The user will get added to (or updated in) that 
specific tenant.  To assign a user to an additional tenant, you can run the same ‘CREATE_OR_UPDATE’ operation 
against the 2nd tenant by changing the tenant Id in the request.  Here is an example using the standard REST API, 
but the same concept may be used with the Manage Persons API: 

Request URL

Tenant #1:
POST https://msast002pngx.domain.com/rest/325884610/ums/managePersons
Tenant #2:
POST https://msast002pngx.domain.com/rest/844143557/ums/managePersons
 
Payload
 
{
    "operation": "CREATE_OR_UPDATE",
    "users": [
        {
            "properties": {
                "FirstName": "SMA-Xuser2",
                "LastName": "Test",
                "OfficePhoneNumber": "1234",
                "Upn": "SMA-Xuser2.test@yopmail.com",
                "Email": "SMA-Xuser2.test@yopmail.com"
            }
        }
    ]
}



Configuration Guide

191

Question: I’m using Case Exchange to exchange Incidents with an external 
system. Agents with the ‘Tenant Admin’ role can see the information on the 
exchanged Incident, but other users can not. How do I make this information 
visible to those agents that need the external ticket number?

Answer: 

Not every role has the ability to see this information in the out of the box system. However, it is possible to add this to 
any role in the system.

First, determine the role or roles that need the right to see the external ticket information. Bring up the role in question 
in the UI, then:

1. Navigate to the ‘Record Type’ section and press ‘Add’ (on the right side of the screen)

2. On the newly displayed window, for the record type field, select ‘External Reference’

3. On the same form, check the box next to ‘View’

4. Press ‘Ok’

5. Save the role using the ‘Save’ button at the top of the screen
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Best Practices

Business Rules

Do not reference a specific record by Id when creating a business rule. Rules defined using an Id are not “portable” 
when you transfer the workflow from development to production as the Ids will be different between the two systems. 
Instead, use a field such as DisplayLabel that will be identical between systems, or use the group_id_by_upn lookup 
function for groups.

Offerings

Service offerings cannot be moved between a development and production system. While creating some offerings in 
development is a good practice for testing and experimentation, all offerings must eventually be created directly in 
production.


